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Notice 
1. All information included in this document is current as of the date this document is issued. Such information, however, is 

subject to change without any prior notice. Before purchasing or using any Renesas Electronics products listed herein, please 
confirm the latest product information with a Renesas Electronics sales office. Also, please pay regular and careful attention to 
additional and different information to be disclosed by Renesas Electronics such as that disclosed through our website. 

2. Renesas Electronics does not assume any liability for infringement of patents, copyrights, or other intellectual property rights 
of third parties by or arising from the use of Renesas Electronics products or technical information described in this document.  
No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights 
of Renesas Electronics or others. 

3. You should not alter, modify, copy, or otherwise misappropriate any Renesas Electronics product, whether in whole or in part. 
4. Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of 

semiconductor products and application examples.  You are fully responsible for the incorporation of these circuits, software, 
and information in the design of your equipment.  Renesas Electronics assumes no responsibility for any losses incurred by 
you or third parties arising from the use of these circuits, software, or information. 

5. When exporting the products or technology described in this document, you should comply with the applicable export control 
laws and regulations and follow the procedures required by such laws and regulations.  You should not use Renesas 
Electronics products or the technology described in this document for any purpose relating to military applications or use by 
the military, including but not limited to the development of weapons of mass destruction.  Renesas Electronics products and 
technology may not be used for or incorporated into any products or systems whose manufacture, use, or sale is prohibited 
under any applicable domestic or foreign laws or regulations. 

6. Renesas Electronics has used reasonable care in preparing the information included in this document, but Renesas Electronics 
does not warrant that such information is error free.  Renesas Electronics assumes no liability whatsoever for any damages 
incurred by you resulting from errors in or omissions from the information included herein. 

7. Renesas Electronics products are classified according to the following three quality grades:  “Standard”, “High Quality”, and 
“Specific”.  The recommended applications for each Renesas Electronics product depends on the product’s quality grade, as 
indicated below.  You must check the quality grade of each Renesas Electronics product before using it in a particular 
application.  You may not use any Renesas Electronics product for any application categorized as “Specific” without the prior 
written consent of Renesas Electronics.  Further, you may not use any Renesas Electronics product for any application for 
which it is not intended without the prior written consent of Renesas Electronics.  Renesas Electronics shall not be in any way 
liable for any damages or losses incurred by you or third parties arising from the use of any Renesas Electronics product for an 
application categorized as “Specific” or for which the product is not intended where you have failed to obtain the prior written 
consent of Renesas Electronics.  The quality grade of each Renesas Electronics product is “Standard” unless otherwise 
expressly specified in a Renesas Electronics data sheets or data books, etc. 

“Standard”: Computers; office equipment; communications equipment; test and measurement equipment; audio and visual 
equipment; home electronic appliances; machine tools; personal electronic equipment; and industrial robots. 

“High Quality”: Transportation equipment (automobiles, trains, ships, etc.); traffic control systems; anti-disaster systems; anti-
crime systems; safety equipment; and medical equipment not specifically designed for life support. 

“Specific”:  Aircraft; aerospace equipment; submersible repeaters; nuclear reactor control systems; medical equipment or 
systems for life support (e.g. artificial life support devices or systems), surgical implantations, or healthcare 
intervention (e.g. excision, etc.), and any other applications or purposes that pose a direct threat to human life. 

8. You should use the Renesas Electronics products described in this document within the range specified by Renesas Electronics, 
especially with respect to the maximum rating, operating supply voltage range, movement power voltage range, heat radiation 
characteristics, installation and other product characteristics. Renesas Electronics shall have no liability for malfunctions or 
damages arising out of the use of Renesas Electronics products beyond such specified ranges. 

9. Although Renesas Electronics endeavors to improve the quality and reliability of its products, semiconductor products have 
specific characteristics such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Further, 
Renesas Electronics products are not subject to radiation resistance design.  Please be sure to implement safety measures to 
guard them against the possibility of physical injury, and injury or damage caused by fire in the event of the failure of a 
Renesas Electronics product, such as safety design for hardware and software including but not limited to redundancy, fire 
control and malfunction prevention, appropriate treatment for aging degradation or any other appropriate measures.  Because 
the evaluation of microcomputer software alone is very difficult, please evaluate the safety of the final products or system 
manufactured by you. 

10. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental 
compatibility of each Renesas Electronics product.  Please use Renesas Electronics products in compliance with all applicable 
laws and regulations that regulate the inclusion or use of controlled substances, including without limitation, the EU RoHS 
Directive.  Renesas Electronics assumes no liability for damages or losses occurring as a result of your noncompliance with 
applicable laws and regulations. 

11. This document may not be reproduced or duplicated, in any form, in whole or in part, without prior written consent of Renesas 
Electronics. 

12. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this 
document or Renesas Electronics products, or if you have any other inquiries. 

(Note 1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its majority-
owned subsidiaries. 

(Note 2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics. 
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Cautions

Keep safety first in your circuit designs!

1. Renesas Technology Corporation puts the maximum effort into making semiconductor products better and more reliable, but

there is always the possibility that trouble may occur with them. Trouble with semiconductors may lead to personal injury, fire

or property damage.

Remember to give due consideration to safety when making your circuit designs, with appropriate measures such as (i)

placement of substitutive, auxiliary circuits, (ii) use of nonflammable material or (iii) prevention against any malfunction or

mishap.

Notes regarding these materials

1. These materials are intended as a reference to assist our customers in the selection of the Renesas Technology Corporation

product best suited to the customer's application; they do not convey any license under any intellectual property rights, or any

other rights, belonging to Renesas Technology Corporation or a third party.

2. Renesas Technology Corporation assumes no responsibility for any damage, or infringement of any third-party's rights,

originating in the use of any product data, diagrams, charts, programs, algorithms, or circuit application examples contained in

these materials.

3. All information contained in these materials, including product data, diagrams, charts, programs and algorithms represents

information on products at the time of publication of these materials, and are subject to change by Renesas Technology

Corporation without notice due to product improvements or other reasons.  It is therefore recommended that customers contact

Renesas Technology Corporation or an authorized Renesas Technology Corporation product distributor for the latest product

information before purchasing a product listed herein.

The information described here may contain technical inaccuracies or typographical errors.

Renesas Technology Corporation assumes no responsibility for any damage, liability, or other loss rising from these

inaccuracies or errors.

Please also pay attention to information published by Renesas Technology Corporation by various means, including the

Renesas Technology Corporation Semiconductor home page (http://www.renesas.com).

4. When using any or all of the information contained in these materials, including product data, diagrams, charts, programs, and

algorithms, please be sure to evaluate all information as a total system before making a final decision on the applicability of

the information and products.  Renesas Technology Corporation assumes no responsibility for any damage, liability or other

loss resulting from the information contained herein.

5. Renesas Technology Corporation semiconductors are not designed or manufactured for use in a device or system that is used

under circumstances in which human life is potentially at stake.  Please contact Renesas Technology Corporation or an

authorized Renesas Technology Corporation product distributor when considering the use of a product contained herein for

any specific purposes, such as apparatus or systems for transportation, vehicular, medical, aerospace, nuclear, or undersea

repeater use.

6. The prior written approval of Renesas Technology Corporation is necessary to reprint or reproduce in whole or in part these

materials.

7. If these products or technologies are subject to the Japanese export control restrictions, they must be exported under a license

from the Japanese government and cannot be imported into a country other than the approved destination.

Any diversion or reexport contrary to the export control laws and regulations of Japan and/or the country of destination is

prohibited.

8. Please contact Renesas Technology Corporation for further details on these materials or the products contained therein.
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Cautions

1. Hitachi neither warrants nor grants licenses of any rights of Hitachi’s or any third party’s
patent, copyright, trademark, or other intellectual property rights for information contained in
this document.  Hitachi bears no responsibility for problems that may arise with third party’s
rights, including intellectual property rights, in connection with use of the information
contained in this document.

2. Products and product specifications may be subject to change without notice. Confirm that you
have received the latest product standards or specifications before final design, purchase or
use.

3. Hitachi makes every attempt to ensure that its products are of high quality and reliability.
However, contact Hitachi’s sales office before using the product in an application that
demands especially high quality and reliability or where its failure or malfunction may directly
threaten human life or cause risk of bodily injury, such as aerospace, aeronautics, nuclear
power, combustion control, transportation, traffic, safety equipment or medical equipment for
life support.

4. Design your application so that the product is used within the ranges guaranteed by Hitachi
particularly for maximum rating, operating supply voltage range, heat radiation characteristics,
installation conditions and other characteristics.  Hitachi bears no responsibility for failure or
damage when used beyond the guaranteed ranges.  Even within the guaranteed ranges,
consider normally foreseeable failure rates or failure modes in semiconductor devices and
employ systemic measures such as fail-safes, so that the equipment incorporating Hitachi
product does not cause bodily injury, fire or other consequential damage due to operation of
the Hitachi product.

5. This product is not designed to be radiation resistant.

6. No one is permitted to reproduce or duplicate, in any form, the whole or part of this document
without written approval from Hitachi.

7. Contact Hitachi’s sales office for any questions regarding this document or Hitachi
semiconductor products.
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IMPORTANT INFORMATION

READ FIRST

• READ this user's manual before using this E6000 emulator.

• KEEP the user's manual handy for future reference.

Do not attempt to use the E6000 emulator until you fully understand its mechanism.

E6000 emulator:
Throughout this document, the term “E6000 emulator” shall be defined as the E6000 emulator,
user system interface cable, PC interface board, and optional boards produced only by Hitachi,
Ltd. excluding all subsidiary products.

The user system or a host computer is not included in this definition.

Purpose of the E6000 emulator:
This E6000 emulator is a software and hardware development tool for systems employing the
Hitachi microcomputer H8/3887 Series, H8/3867 Series, H8/3847 Series, H8/3827 Series,
H8/3847R Series, and H8/3827R Series (hereafter referred to as MCU). This E6000 emulator must
only be used for the above purpose.

Improvement Policy:
Hitachi, Ltd. (including its subsidiaries, hereafter collectively referred to as Hitachi) pursues a
policy of continuing improvement in design, functions, performance, and safety of the E6000
emulator.  Hitachi reserves the right to change, wholly or partially, the specifications, design,
user's manual, and other documentation at any time without notice.

Target User of the E6000 emulator:
This E6000 emulator should only be used by those who have carefully read and thoroughly
understood the information and restrictions contained in the user's manual. Do not attempt to use
the E6000 emulator until you fully understand its mechanism.

It is highly recommended that first-time users be instructed by users that are well versed in the
operation of the E6000 emulator.



II

LIMITED WARRANTY

Hitachi warrants its E6000 emulators to be manufactured in accordance with
published specifications and free from defects in material and/or
workmanship. Hitachi, at its option, will repair or replace any E6000
emulators returned intact to the factory, transportation charges prepaid, which
Hitachi, upon inspection, determine to be defective in material and/or
workmanship. The foregoing shall constitute the sole remedy for any breach
of Hitachi's warranty. See the Hitachi warranty booklet for details on the
warranty period. This warranty extends only to you, the original Purchaser.
It is not transferable to anyone who subsequently purchases the emulator
product from you. Hitachi is not liable for any claim made by a third party or
made by you for a third party.

DISCLAIMER

HITACHI MAKES NO WARRANTIES, EITHER EXPRESS OR IMPLIED,
ORAL OR WRITTEN, EXCEPT AS PROVIDED HEREIN, INCLUDING
WITHOUT LIMITATION THEREOF, WARRANTIES AS TO
MARKETABILITY, MERCHANTABILITY, FITNESS FOR ANY
PARTICULAR PURPOSE OR USE, OR AGAINST INFRINGEMENT OF
ANY PATENT. IN NO EVENT SHALL HITACHI BE LIABLE FOR ANY
DIRECT, INCIDENTAL OR CONSEQUENTIAL DAMAGES OF ANY
NATURE, OR LOSSES OR EXPENSES RESULTING FROM ANY
DEFECTIVE E6000 EMULATOR, THE USE OF ANY E6000
EMULATOR, OR ITS DOCUMENTATION, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGES.  EXCEPT AS EXPRESSLY
STATED OTHERWISE IN THIS WARRANTY, THIS E6000 EMULATOR
IS SOLD “AS IS ”, AND YOU MUST ASSUME ALL RISK FOR THE USE
AND RESULTS OBTAINED FROM THE E6000 EMULATOR.
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State Law:

Some states do not allow the exclusion or limitation of implied warranties or liability for
incidental or consequential damages, so the above limitation or exclusion may not apply to you.
This warranty gives you specific legal rights, and you may have other rights which may vary from
state to state.

The Warranty is Void in the Following Cases:

Hitachi shall have no liability or legal responsibility for any problems caused by misuse, abuse,
misapplication, neglect, improper handling, installation, repair or modifications of the E6000
emulator without Hitachi's prior written consent or any problems caused by the user system.

All Rights Reserved:

This user's manual and E6000 emulator are copyrighted and all rights are reserved by Hitachi.  No
part of this user's manual, all or part, may be reproduced or duplicated in any form, in hard-copy
or machine-readable form, by any means available without Hitachi's prior written consent.

Other Important Things to Keep in Mind:

1. Circuitry and other examples described herein are meant merely to indicate the characteristics
and performance of Hitachi's semiconductor products. Hitachi assumes no responsibility for
any intellectual property claims or other problems that may result from applications based on
the examples described herein.

2. No license is granted by implication or otherwise under any patents or other rights of any third
party or Hitachi.

Figures:

Some figures in this user's manual may show items different from your actual system.

Limited Anticipation of Danger:

Hitachi cannot anticipate every possible circumstance that might involve a potential hazard.  The
warnings in this user's manual and on the E6000 emulator are therefore not all inclusive.
Therefore, you must use the E6000 emulator safely at your own risk.
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SAFETY PAGE
READ FIRST

• READ this user's manual before using this E6000 emulator.

• KEEP the user's manual handy for future reference.

Do not attempt to use the E6000 emulator until you fully understand its mechanism.

DEFINITION OF SIGNAL WORDS

This is the safety alert symbol.  It is used to alert you to potential personal
injury hazards.  Obey all safety messages that follow this symbol to avoid
possible injury or death.

DANGER DANGER indicates an imminently hazardous situation which, if not
avoided, will result in death or serious injury.

WARNING WARNING indicates a potentially hazardous situation which, if not
avoided, could result in death or serious injury.

CAUTION CAUTION indicates a potentially hazardous situation which, if not
avoided, may result in minor or moderate injury.

CAUTION CAUTION used without the safety alert symbol indicates a
potentially hazardous situation which, if not avoided, may result
in property damage.

NOTE emphasizes essential information.
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WARNING
Observe the precautions listed below.  Failure to do so

will result in a FIRE HAZARD and will damage the user
system and the E6000 emulator or will result in PERSONAL
INJURY.  The USER PROGRAM will be LOST.

1. Do not repair or remodel the emulator product by
yourself for electric shock prevention and quality
assurance.

2. Always switch OFF the E6000 emulator and user system
before connecting or disconnecting any CABLES or
PARTS.

3. Always before connecting any CABLES, make sure that
pin 1 on both sides are correctly aligned.

4. Supply power according to the power specifications and
do not apply an incorrect power voltage. Use only the 
provided power cable.
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CAUTION
This equipment has been tested and found to comply

with the limits for a Class A digital device, pursuant to part 15
of the FCC Rules.  These limits are designed to provide
reasonable protection against harmful interference when the
equipment is operated in a commercial environment.  This
equipment generates, uses, and can radiate radio frequency
energy and, if not installed and used in accordance with the
instruction manual, may cause harmful interference to radio
communications.  Operation of this equipment in a residential
area is likely to cause harmful interference in which case the
user will be required to correct the interference at his own
expense.
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About This Manual

This emulator (HS388REPI60H) supports the following MCUs.  In this manual, only the MCU
names are shown.

Device to be Supported MCU

H8/3887, 3886, 3885, 3884, 3883, 3882 H8/3887 series

H8/3867, 3866, 3865, 3864, 3863, 3862 H8/3867 series

H8/3847, 3846, 3845, 3844, 3843, 3842 H8/3847 series

H8/3827, 3826, 3825, 3824, 3823, 3822 H8/3827 series

H8/3847R, 3846R, 3845R, 3844R, 3843R, 3842R H8/3847R series

H8/3827R, 3826R, 3825R, 3824R, 3823R, 3822R H8/3827R series

This manual explains how to set up and use the E6000 emulator for the H8/3887 series, H8/3867
series, H8/3847 series, H8/3827 series, H8/3847R series, and H8/3827R series of microcomputers.
This manual describes the debugging platform.

Section 1, Introduction, gives a rapid introduction to the system’s facilities, including an overview
of the main emulation features provided by the E6000 emulator and the Hitachi debugging
interface (HDI) software that provides access to them.

Section 2, Setting Up, describes how to set up the E6000 emulator and prepare it for use in
conjunction with the HDI.

Section 3, Hardware, explains how to connect the E6000 emulator to an external user system.

Section 4, Tutorial, then introduces each of the E6000 emulator’s main features by showing how
to load and debug a simple C program. The tutorial program is supplied on disk so that you can
follow the steps on your own system to learn first-hand how it operates.

Section 5, Reference, gives detailed information about the features of the HDI software.

Section 6, Command Line Functions, gives details of the additional H8/3887 Series, H8/3867
Series, H8/3847 Series, H8/3827 Series, H8/3847R Series, and H8/3827R Series-specific
command line functions.

Section 7, Diagnostic Test Procedure, gives the diagnostic test procedure using the E6000
emulator test program.
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Assumptions

This manual assumes that you already have a working knowledge of the procedures for running
and using applications for MS-DOS® and Microsoft® Windows® operating system.

Related Manuals

• Hitachi Debugging Interface User’s Manual

• User System Interface Cable User’s Manual

• PC Interface Board User’s Manual

ISA Bus Interface Board User's Manual (HS6000EII01HE)

PCI Bus Interface Board User's Manual (HS6000EIC01HE or HS6000EIC02HE)

PCMCIA Interface Card User's Manual (HS6000EIP01HE)

Description Notes on Using LAN Adapter for E6000/E8000 Emulator (HS6000ELN01HE)

Conventions

This manual uses the following typographical conventions:

Style Used for

computer Text that you type in.

parameter A label representing the actual value you should type as part of a command.

bold Names of menus, menu commands, buttons, dialog boxes, text that appears on
the screen, and windows that appear on the screen.

Trademarks

• Microsoft®, MS-DOS®, Windows®, Windows® 95, Windows® 98, Windows NT® 4.0, and
Windows® 2000 are registered trademarks of Microsoft Corporation in the United States and/or
in other countries.

• IBM is a registered trademark of International Business Machines Corporation.

• The operating environment in this manual is Microsoft® Windows® 98 for English version on
the IBM PC.
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Section 1   Introduction

The E6000 emulator is an advanced realtime in-circuit emulator which allows programs to be
developed and debugged for the H8/3887 Series, H8/3867 Series, H8/3847 Series, H8/3827
Series, H8/3847R Series, and H8/3827R Series of microcomputers.

The E6000 emulator can either be used in stand-alone mode, for software development and
debugging, or connected via a user system interface cable to a user system, for debugging user
hardware.

The E6000 emulator works with the Hitachi debugging interface (HDI), an application for
Microsoft® Windows® operating system. This provides a powerful range of commands for
controlling the emulator hardware, with a choice of either fully interactive or automated
debugging.

1.1 Debugging Features

1.1.1 Breakpoints

The E6000 emulator provides a comprehensive range of alternative types of breakpoints, to give
you the maximum flexibility in debugging applications and user system hardware.

Hardware Break Conditions: Up to 12 breakpoints can be defined using the event and range
channels in the complex event system (CES). For more information about the hardware
breakpoints see section 1.2, Complex Event System (CES).

Program Breakpoints (PC Breakpoints): Up to 256 program breakpoints can be defined. These
program breakpoints are set by replacing the user instruction by a BREAK instruction.

1.1.2 Trace

The E6000 emulator incorporates a powerful realtime trace facility which allows you to examine
MCU activity in detail. The realtime trace buffer holds up to 32768 bus cycles, and it is
continuously updated during execution. The buffer is configured as a rolling buffer, which can be
stopped during execution and read back by the host computer without halting emulation.

The data stored in the trace buffer is displayed in both source program and assembly languages for
ease of debugging.
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The buffer can be set up to store all bus cycles or just selected cycles. This is called trace
acquisition and uses the complex event system (CES) to select the parts of the program you are
interested in; see section 1.2, Complex Event System (CES), for more information.

It is also possible to store all bus cycles and then just look at selected cycles. This is called trace
filtering.

1.1.3 Execution Time Measurements

The E6000 emulator allows you to make measurements of the total execution time, or to measure
the time of execution between specified events in the complex event system. You can set the
resolution of the timer to any of the following values:

20 ns, 125 ns, 250 ns, 500 ns, 1 µs, 2 µs, 4 µs, 8 µs or 16 µs.

At 20 ns the maximum time that can be measured is six hours, and at 16µs the maximum time is
about 200 days.

1.2 Complex Event System (CES)

In most practical debugging applications the program or hardware errors that you are trying to
debug often only occur under a certain very restricted set of circumstances. For example, a
hardware error may only occur after a specific area of memory has been accessed. Tracking down
such problems using simple PC breakpoints can be very time consuming.

The E6000 emulator provides a very sophisticated system for giving a precise description of the
conditions you want to examine, called the complex event system. This allows you to define
events which depend on the state of a specified combination of the MCU signals.

The complex event system provides a unified way of controlling the trace, break, and timing
functions of the E6000 emulator.

1.2.1 Event Channels

The event channels allow you to detect when a specified event has occurred. The event can be
defined as a combination of one or more of the following:

• Address or address range

• Address outside range

• Data, with an optional mask

• Read or Write or either

• MCU access type (instruction prefetch, data fetch, etc)

• MCU access area (internal ROM, internal RAM, etc)
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• A signal state on one or more of the four external probes

• A certain number of times that the event must be triggered

• Delay cycles after an event.

Up to eight events can be combined into a sequence, in which each event is either activated or
deactivated by the occurrence of the previous event in the sequence. For example, you can cause a
break if an I/O register is written to after a specified area of RAM has been accessed.

1.2.2 Range Channels

The range channels can be set up to be triggered on a combination of one or more of the
following:

• Address or address range (inside the range)

• Data, with an optional mask

• Read or Write or either

• MCU access type (instruction prefetch, data fetch, etc)

• MCU access area (internal ROM, internal RAM, etc)

• A signal state on one or more of the four external probes

• Delay cycles after an event

1.2.3 Breaks and Timing

The complex event system can be used to control the following functions of the E6000 emulator:

Breaks: You use breaks to interrupt program execution when a specified event, or sequence of
events, is activated. For example, you can set up a break to halt execution when the program is
read from one address, and then written to another address. The break can also optionally be
delayed by up to 65535 bus cycles.

Timing: You can perform precise timing measurements on sections of your program by setting up
two events, and then timing the execution of the program between the activation of the first event
and the activation of the second event.
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1.3 Hardware Features

1.3.1 Memory

The E6000 emulator provides internal ROM/RAM memory as standard emulation memory.

The emulation memory can be mapped in one-byte units to the MCU address space. Each of
memory can be specified using the Configure Map… command as user (Target) or emulator
(internal ROM/RAM memory) and, in each case, the access can be specified as read-write, read-
only, or guarded.

The definition of each type of memory is as follows:

Table 1.1 Memory Type

Memory type Description

Internal Uses the MCU internal memory.

Emulator Uses the emulation board memory.

The contents of a specified block of memory can be displayed using the Memory… command.
The contents of memory can be modified at any time, even during program execution and the
results are immediately reflected in all other appropriate windows.
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1.3.2 Operating Voltage and Frequency Specifications

Table 1.2 shows examples of the MCU operating voltage and frequency specifications supported
by the E6000 emulator.  Note that some MCUs do not guarantee the low-voltage operation or
high-frequency operation.

Table 1.2   Operating Voltage and Frequency Specifications

MCU Types Operating Voltage (V)
Operating Frequency
Range (fosc) (MHz)

H8/3847R series 1.8-5.5 2.0-4.0

H8/3827R series 2.7-5.5 2.0-10.0

4.5-5.5 2.0-16.0

H8/3887 series 1.8-5.5 0.4-1.0

H8/3867 series 2.2-5.5 0.4-2.0

H8/3847 series 2.6-5.5 0.4-3.2

H8/3827 series 3.0-5.5 0.4-4.0

4.5-5.5 0.4-6.0
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1.3.3 Clocks

The system clock and subclock can be programmed to the following frequencies.

Table 1.3 Clock Frequencies

Emulator Emulation Clock MCU Frequency Selection

HS388REPI60H System clock H8/3887 series,
H8/3867 series,
H8/3847 series, and
H8/3827 series

2 MHz, 0.5 MHz,
or target clock/2

H8/3847R series and
H8/3827R series

8 MHz, 2 MHz, 0.5 MHz,
or target clock/2

Sub-clock H8/3887 series,
H8/3867 series,
H8/3847 series,
H8/3827 series,
H8/3847R series, and
H8/3827R series

32.768 kHz, 38.4 kHz,
307.2 kHz, or target sub-clock

1.3.4 External Probes

Up to four external probes can be connected to the E6000 emulator, to make use of signals from
other parts of your user system hardware, and can be used to trigger the complex event system
depending on whether the probe signal is low or high. When the external probes are not
connected, the signals are fixed high. The state of a signal can be displayed in the trace window
(high = 1, low = 0).

1.3.5 Environment Conditions

Observe the conditions listed in the following.
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Table 1.4 Environment Conditions

Item Specifications

Operating : +10 to +35°CTemperature

Storage : –10 to 50°C

Operating : 35 to 80% RH no condensationHumidity

Storage : 35 to 80% RH no condensation

Ambient gases Must be no corrosive gases

AC input voltage 100 V to 240 V ± 10%

AC input frequency 50/60 Hz

AC current 0.6 A max.

AC input cable* HS388REPI60H HS388REPI60HB

100 V - 120 V (UL) 200 V - 240 V (BS)

User system voltage 1.8 V to 5.5 V

Note: HS388REPI60H must be used at AC100 V – 120 V input voltage.
HS388REPI60HB must be used at AC200 V – 240 V input voltage.

1.3.6 Emulator External Dimensions and Mass

Dimensions: 219 × 160 × 54 mm

Mass: 970 g
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Section 2   Setting Up

This section describes how to set up the E6000 emulator using the PC interface board and prepare
it for use in conjunction with the Hitachi Debugging Interface (HDI).

This section explains how to:

• Set up the PC interface board.

• Set up the E6000 emulator.

• Install the HDI software and use it to check correct operation of the entire system.

2.1 Package Contents

The E6000 emulator is supplied in a package containing the following components.

• E6000 emulator

• 5V 6A E6000 emulator power supply with AC cable

• HDI installation disk (HS388REPI60SR)

• External probes

• Hitachi Debugging Interface for E6000 Setup Guide

Before proceeding you should check that you have all the items listed above, and contact your
supplier if any are missing.

You also need an IBM PC or compatible as the host computer running Microsoft Windows 98
(hereinafter referred to as Windows 98) or Windows NT operating system, which is not supplied
as part of the E6000 emulator package.

2.2 Installing the PC Interface Board

The PC interface board (HS6000EII01H) is a memory mapped board, and before using it you first
need to reserve a block of memory addresses for use by the board. This ensures that other
programs do not inadvertently use the PC interface hardware.

The allocated memory area must not overlap memory already allocated to other board. If
attempted, the PC interface board and the E6000 emulator product will not operate correctly. At
shipment, the memory area of PC interface board is allocated to the address range from H'D0000
to H'D3FFF.

2.2.1 Setting Up

• Start up the Windows 98.
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• Click the My Computer icon with the right button of the mouse to select Properties from the
pop-up menu.

The System Properties dialog box will be displayed.

• Double-click the Computer icon on the Device Manager panel to open the Computer
Properties dialog box.

• Click the Memory in the View Resources panel to display the memory resources.

Figure 2.1   Computer Properties Dialog Box (Before Setting Up)

A memory area that is not listed in the dialog box can be assigned to the PC interface board.
Table 2.1 lists the address ranges that can be set by the switch on the rear panel of the PC interface
board.  Select one of the address ranges that is not listed in the Computer Properties dialog box.
For example, if you select the range H'D8000 to H'DBFFF, the corresponding switch number will
be 6.
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Table 2.1 Address Map of PC Interface Board and Memory Switch Setting

Address Range Switch

From H'C0000 to H'C3FFF 0

From H'C4000 to H'C7FFF 1

From H'C8000 to H'CBFFF 2

From H'CC000 to H'CFFFF 3

From H'D0000 to H'D3FFF (at shipment) 4

From H'D4000 to H'D7FFF 5

From H'D8000 to H'DBFFF 6

From H'DC000 to H'DFFFF 7

From H'E0000 to H'E3FFF 8

From H'E4000 to H'E7FFF 9

From H'E8000 to H'EBFFF A

From H'EC000 to H'EFFFF B

Define the memory area so that Windows® 98 does not use the area as follows:

• Click Memory in the Reserve Resources panel and click Add.

The Edit Resource Setting dialog box will be displayed.

Figure 2.2   Edit Resource Setting Dialog Box

• Enter the memory area addresses in Start value and End value.

• Shut down the host computer (do not restart it) and turn off the power switch.
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• Using a small screwdriver, rotate the switch in the rear panel of the PC interface board so that
the arrow points to the number corresponding to the memory area you have selected.

• Remove the cover from the host computer and install the PC interface board in a spare ISA
slot.

• Replace the host computer cover.

• Connect the PC interface cable between the PC interface board and the PC IF connector on the
E6000 emulator. Press each plug firmly until it clicks into position.

• Switch on the host computer.

• Open the Computer Properties dialog box and check that the memory area you have selected
is listed as System Reserved.

Figure 2.3   Computer Properties Dialog Box (After Setting up)
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2.3 Setting Up the PC Interface Board on Windows NT® 4.0

The PC interface board uses the ISA bus slot, and therefore the host computer must have a spare
ISA bus slot.

This section describes the general procedure for installing the PC interface board in the host
computer.  For details, refer to the manual of your host computer.

Starting Windows NT®:

• Execute Start/Programs/Administrative Tools (Common)/Windows NT Diagnostics.

• Click the Memory button in the Resource tab and, in the following form, make a note of the
upper memory areas that have already been used.

# Start End # Start End # Start End

0 4 8
1 5 9
2 6 A
3 7 B

• Shut down Windows NT®.

Starting the Host Computer in Setup Mode:

For details on the setup mode, refer to the manual of your host computer.

• Check the upper memory areas that have already been used.

# Start End # Start End # Start End

0 4 8
1 5 9
2 6 A
3 7 B

The memory areas being used should be the same as those checked for Windows NT® above.

• Define the memory area for the PC interface board.  Select one of the memory areas that
correspond to the following PC interface board switch settings, and no other devices can
access the selected memory area.
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# Start End # Start End # Start End

0 H'C0000 H'C3FFF 4 H'D0000 H'D3FFF 8 H'E0000 H'E3FFF

1 H'C4000 H'C7FFF 5 H'D4000 H'D7FFF 9 H'E4000 H'E7FFF

2 H'C8000 H'CBFFF 6 H'D8000 H'DBFFF A H'E8000 H'EBFFF

3 H'CC000 H'CFFFF 7 H'DC000 H'DFFFF B H'EC000 H'EFFFF
Note: 4 is the setting at shipment.

If the Intel P&P BIOS  disk is supplied with the host computer, define the memory area as
follows:

• Start the host computer with the Intel P&P BIOS disk.

• Check the upper memory areas that have already been used, with View/System Resources.

• Add Unlisted Card with Configure/Add Card/Others....

• Click No in the dialog box displayed because there is no .CFG file.

• Move to the Memory [hex] list box in the Configure Unlisted Card dialog box.

• Click the Add Memory... button to display the Specify Memory dialog box.

• Enter a memory area range that is not used by any other device and that corresponds to one of
the PC interface board switch settings.

• Save the file.

• Exit the current setup program.

• Shut down the host computer (do not restart it) and turn off the power switch.

• Using a small screwdriver, rotate the switch in the rear panel of the PC interface board so that
the arrow points to the number corresponding to the memory area you have selected.

• Remove the cover from the host computer and install the PC interface board in a spare ISA
slot.

• Replace the host computer cover.

• Connect the PC interface cable between the PC interface board and the PC IF connector on the
E6000 emulator. Press each plug firmly until it clicks into position.

• Switch on the host computer.

2.4 Installing the HDI

To install the HDI, refer to Hitachi Debugging Interface for E6000 Setup Guide.
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2.5 Troubleshooting

2.5.1 Faulty Connection

If the following message box appears during initialization, the PC interface board was not able to
detect the E6000 emulator.

Figure 2.4   Faulty Connection Message

This indicates:

• Power supply not connected to the E6000 emulator, or the emulator not switched on. Check
the power LED on the E6000 emulator.

• The PC interface cable is not correctly connected between the PC interface board and the
E6000 emulator.

2.5.2 Communication Problems

The following message box indicates that the HDI was not able to set up the E6000 emulator
correctly:

Figure 2.5   Communication Problem Message
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This indicates:

• The memory area reserved in the CONFIG.SYS file does not match the interface switch
setting on the rear panel of the PC interface board.

• The selected area of memory is in use by another application.

• Check the settings according to section 2.2, Installing the PC Interface Board, or section 2.3,
Setting Up the PC Interface Board on Windows NT® 4.0.
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Section 3   Hardware

This section explains how to connect the E6000 emulator to user system.

3.1 Connecting to the User System

To connect the E6000 emulator to a user system proceed as follows:

• Connect the user system interface cable head to the user system.

• Plug the cable body into the E6000 emulator.

• Plug the cable body into the cable head.

For details of these steps, refer to the User System Interface Cable User’s Manual.

Figure 3.1 gives details of the connectors provided on the E6000 emulator.

Figure 3.1   E6000 Emulator Connectors



18

3.1.1 Connecting Example of the User System Interface Cable Head to the User System

Figure 3.2   Connecting User System Interface Cable Head to User System

• Ensure that all power is off to the E6000 emulator, user system, and associated equipment.

• Insert the user system interface cable head into the socket on the user system.

Note: Depending upon the QFP package it may be possible to orientate this cable head in any
position on the socket, so care should be taken to correctly identify pin 1 on the E6000
emulator part and socket when installing.

• Screw the cable head to the socket with the screws provided. Progressively tighten the screws
in the sequence shown in figure 3.3 until all are ‘finger tight’.

1 3

4 2

Figure 3.3   Sequence of Screw Tightening

Note: Be careful not to over-tighten the screws as this may result in contact failure on the user
system hardware or damage the cable head. Where provided, use the ‘solder lugs’ on the
QFP socket to provide extra strength to the E6000 emulator/user system connection.
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3.1.2 Plugging the User System Interface Cable Body into the E6000 Emulator

Plug the user system interface cable body into the E6000 emulator, taking care to insert it straight,
and push it firmly into place.

External probes

POWER RUN

E6000 emulator

User system interface cableCable head

Cable body

Figure 3.4   Plugging User System Interface Cable Body to E6000 Emulator

3.1.3 Plugging the User System Interface Cable Body into the Cable Head

Plug the user system interface cable body into the user system interface cable head on the user
system hardware.
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3.2 Power Supply

3.2.1 AC Power-Supply Adapter

The AC adapter supplied with the E6000 emulator must be used at all times.

3.2.2 Polarity

Figure 3.5 shows the polarity of the power-supply plug.

Figure 3.5   Polarity of Power Supply Plug

3.2.3 Power Supply Monitor Circuit

The E6000 emulator incorporates a user-system power supply monitor circuit which only lights
the red LED when a voltage higher than 4.75 V is supplied. If this LED does not light, you should
check the E6000 emulator voltage level. An input voltage less than 4.75 V could indicate that
sufficient power is not supplied to the E6000 emulator.

Note: Use the provided AC power-supply adapter for the E6000 emulator.
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3.3 Hardware Interface

All user system interface signals of the E6000 emulator are directly connected to the evaluation
chip on the E6000 emulator with no buffering.

3.3.1 Signal Protection

All user system interface signals are protected from over- or under-voltage by use of diode arrays
except for the AVcc and analog port signals.

Pull-up resistors are connected to the port signals except for the analog port signals.

The E6000 monitors the signals at the head of the user system interface cable to detect whether the
user system hardware is connected.

3.3.2 User System Interface Circuits

The circuits that interface the evaluation chip on the E6000 emulator to the user system include
pull-up resistors that cause signal delays. Note that when an input pin is in the high-impedance
state, the pull-up resistor forces the pin to be at a high level. Adjust the user system hardware to
compensate for these effects. The delay caused by the user system interface cable is about 8 ns.

The following diagrams show the user system interface signal circuits.

Signals Other than below:

Vcc

User system interface cableEvaluation 
chip 47 

470 k

Figure 3.6   User System Interface Circuit for Other Signals

OSC1 and X1:

Evaluation
chip 47 

10 k 

Vcc

User system interface cable

Figure 3.7   User System Interface Circuit for OSC1 and X1
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PB0/AN0 to PB7/AN7, PC0 to PC3, P50/WKP0/SEG1 to P57/WKP7/SEG8, P60/SEG9 to
P67/SEG16, P70/SEG17 to P77/SEG24, P80/SEG25 to P87/SEG32, P90/SEG33 to
P97/SEG40/CL1, and PA0/COM1 to PA3/COM4:.

Figure 3.8   User System Interface Circuit for PB0/AN0 to PB7/AN7, PC0 to PC3,
P50/WKP0/SEG1 to P57/WKP7/SEG8, P60/SEG9 to P67/SEG16, P70/SEG17 to P77/SEG24,
P80/SEG25 to P87/SEG32, P90/SEG33 to P97/SEG40/CL1, and PA0/COM1 to PA3/COM4

AVcc and AVss:

Figure 3.9   User System Interface Circuit for AVcc and AVss

CVcc and TEST:

When CVcc is connected to GND, or TEST is connected to Vcc level, a warning message is
displayed at HDI initiation. Check the CVcc and TEST pins on the user system.

Figure 3.10   User System Interface Circuit for CVcc and TEST

V0, V1, V2, and V3:

Evaluation 
chip

User system interface cable

Figure 3.11   User System Interface Circuit for V0, V1, V2, and V3
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P30/PWM to P37/AEVL and P40/RCK32 to P43/IRQ0:

User system interface cableEvaluation 
chip 47 

470 k 

Vcc

Figure 3.12 User System Interface Circuit for P30/PWM to P37/AEVL and P40/RCK32 to
P43/IRQ0

3.3.3 Clock Oscillator

Figure 3.13 shows the system clock oscillator on the user system interface cable. This oscillator is
designed to oscillate in the range of 1 MHz to 16 MHz. For details, refer to the user system
interface cable manuals.

(OSC1) (OSC2)

System clock Sub-clock

1 M

HCU04 HCU04

270

EXTAL XTAL

3.3 M

HCU04

HCU04 HCU04 HCU04

2.2 k

X1 X2

E6000 emulator

10 k

E6000 emulator

Figure 3.13   Oscillator Circuit

3.3.4 External Probes/Trigger Output

An 8-pin connector, marked EXT (next to the user interface connector), on the E6000 emulator
case accommodates four external probe inputs and two trigger outputs. The pinout of this
connector is shown in figure 3.14.
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Figure 3.14   External Probe Connector

The external probe interface circuit is shown in figure 3.15.

Figure 3.15   External Probe Interface Circuit

The trigger output is controlled by event channel 8 and is low active. The trigger output is
available as either T5 V (probe color: white; within the range from 2.5 V to 5 V and does not
depend on the user VCC level) or TUVCC (probe color: yellow; the user VCC level). When the TUVCC is
used, user system cannot be evaluated at the power voltage of 1.8 V. (The voltage must be within
the range 2.0 V to 5.0 V.)

3.3.5 Voltage Follower Circuit

CAUTION

1. Do not connect the user system interface cable to the E6000 emulator without
user system connection.

2. Turn on the user system before starting up the E6000 emulator.

A voltage follower circuit is implemented on the E6000 emulator which allows the user system
voltage level from the user system to be monitored. This monitored voltage level is automatically
supplied to the logic on the E6000 emulator and is derived from the E6000 emulator power supply
unit. This means that no power is taken from the user system board.
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If no user system interface cable is connected to the E6000 emulator, the E6000 emulator will
operate at a specified voltage and all clock frequencies will be available to the user. If the user
system interface cable is attached, the E6000 emulator will match the voltage supplied to the user
system in all cases; i.e. even when the user VCC is below the operating voltage for the MCU. You
must be careful not to select an invalid clock frequency if operating at less than 5 V.

You can set a user VCC threshold in the range Vcc max. – 0 V by using the E6000 emulator
configuration dialog box. If the user VCC drops below this threshold, the User System Voltage in
the Platform  sheet of the System Status window will display Down, otherwise OK is displayed.
When the user system interface cable is disconnected, the E6000 emulator Vcc level is Vcc max.

Figure 3.16   Voltage Level Monitoring
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3.4 Differences between MCU and E6000 Emulator

When the E6000 emulator is initialized or the system is reset there are some differences in the
initial values in some of the general registers as shown in table 3.1.

Table 3.1 Initial Value Differences between MCU and E6000 Emulator

Status Register E6000 Emulator MCU

PC Undefined Reset vector value

R0 to R6 0000 Undefined

R7 (SP) 0010 Undefined

Power-on

CCR The I mask is set to 1 and the
other bits are undefined

The I mask is set to 1 and the
other bits are undefined

PC Reset vector value Reset vector value

R0 to R6 Undefined Undefined

R7 (SP) 0010 Undefined

Reset command

CCR The I mask is set to 1 and the
other bits are undefined

The I mask is set to 1 and the
other bits are undefined

Please refer to section 3.3, Hardware Interface, for details of the protection circuitry used on the
I/O ports of the E6000 emulator.

3.4.1 A/D Converter

Due to the use of a user system interface cable there is a slight degradation in the A/D resolution
and above that quoted in the Hardware Manual for the MCU being emulated.

3.4.2 Access to Unused Area

The unused area from H'FF80 to H'FF8F is used by the emulator system. Therefore, if this area is
allocated to the emulator by the MAP setting, the operation is not guaranteed. Do not use this area.

Do not access the register that is not used by the MCU with the emulator.

3.4.3 Program Execution by the Go Reset Command

When the program is executed using the Go Reset command, the E6000 emulator inputs a 500-µs
reset signal to the evaluation chip. This reset signal input time is added when the execution time
measurement result is displayed.
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Section 4   Tutorial

The following describes a sample debugging session, designed to introduce the main features of
the E6000 emulator used in conjunction with the Hitachi debugging interface (HDI) software.

The tutorial is designed to run in the E6000 emulator’s resident memory so that it can be used
without connecting the E6000 emulator to a user system.

The tutorial assumes that the H8/3887 E6000 is used.  When using another type of E6000
emulator, change the file and directory names to your target ones.

4.1 Introduction

The tutorial is based on a simple C program.

Before reading this chapter:

• Set up the E6000 emulator from the HDI software. See section 2, Setting Up. You do not need
to connect the E6000 emulator to a user system to use this tutorial.

• Make sure you are familiar with the architecture and instruction set of the MCU. For more
information, refer to the Hardware Manual and Programming Manual for the target MCU.

The tutorial program arranges ten random data in ascending/descending order. The source
program (Sort.C ), and the object file in the ELF/DWARF2 format (Tutorial.abs ) are
provided in the HDI installation disk.
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4.2 Starting HDI

To start the HDI:

• Select Hitachi Debugging Interface from HDI for E6000 H8_3880R of the Start menu.

Figure 4.1   HDI Start Menu

4.2.1 Selecting the Target Platform

The HDI has extended functions for supporting multiple target platforms, and if your system is set
up for more than one platform you will first be prompted to choose the target platform.

Figure 4.2   Select Platform Dialog Box
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• For this tutorial select E6000 H8/3887 and H8/3847 Emulator  and click OK  to
continue.

Note that you can change the target platform at any time by choosing New Session… from the
File menu.

When the emulator has been successfully set up, the Hitachi Debugging Interface window will
be displayed, with the message Link up  in the status bar.

Figure 4.3   Hitachi Debugging Interface Window

For the key features of HDI, see Hitachi Debugging Interface User’s Manual. For the functions
specialized for the E6000 emulator, refer to the on-line help.

Menu Bar:   Gives you access to the HDI commands for setting up the E6000 emulator and using
the HDI debugging functions.

Tool Bar:   Provides convenient buttons as shortcuts for the most frequently used menu
commands.

Program Window:  Displays the source of the program being debugged.

Status Bar:  Displays the status of the E6000 emulator. For example, progress information about
downloads, snapshots of address bus in run mode.

Help Button:   Activates context sensitive help about any feature of the HDI user interface.
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4.3 Setting up the E6000 Emulator

Before downloading a program to the E6000 emulator, you first need to set up the target MCU
conditions. The following items need to be configured:

• The device type

• The operating mode

• The clock source

• The user signals

• The memory map

The following sections describe how to set up the E6000 emulator as appropriate for the tutorial
program.

4.3.1 Configuring the Platform

To set up the target configuration:

• Choose Configure Platform…  from the Setup menu to set up the conditions for the selected
platform.

• The following dialog box will be displayed:

Figure 4.4   Configuration Dialog Box
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• Set up the options as shown in table 4.1

Table 4.1 Target Configuration Options

Option Value

Device H8/3887

Mode 3 (single chip)

Clock 0.5 MHz

Timer resolution 125 ns

User VCC level (threshold) 4.00 V

All other options Enabled

• Click OK  to change the target configuration.

4.3.2 Mapping the Memory

After you have selected the device and mode in the Configuration Dialog Box, the HDI
automatically maps the E6000 emulator memory for the device and mode you have selected.

• To display the current memory mapping, choose Configure Map... from the Memory menu,
or click the Memory Map button in the toolbar.

The Memory Mapping dialog box shown in figure 4.5 is displayed.

Figure 4.5   Memory Mapping Dialog Box
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Table 4.2 lists the two memory types available in the E6000 emulator.

Table 4.2 Memory Type

Memory Type Description

Internal Accesses the MCU internal memory.

Emulator Accesses the emulation memory.

Table 4.3 lists the three access types.

Table 4.3 Access Types

Access Type Description

Read-write RAM.

Read-only ROM.

Guarded No access allowed.

For this tutorial, we can use the default mapping, but you can edit the mapping as follows:

• To change the map setting, click the Edit  button after selecting the target mapping line, or
simply double-click that line.

Here, double-click the On Chip Read-only  in the Memory Mapping dialog box.

The Edit Memory Mapping  dialog box is displayed.

Figure 4.6   Edit Memory Mapping Dialog Box

• Click OK  to close the dialog box.
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• To display the device map information, select Status from the View menu or click the Status
button in the toolbar to open the System Status window, and select the Memory sheet.  The
device map information is then displayed as follows:

Figure 4.7   System Status Window (Memory Sheet)

Note: The memory map differs according to the target MCU.

4.4 Downloading the Tutorial Program

After the E6000 emulator is set up, you can download the object program you want to debug.

4.4.1 Loading the Object File

First load the ELF/DWARF2-format object file, as follows:

• Choose Load Program... from the File menu, or click the Load Program button in the
toolbar.  The Load Program dialog box is then displayed.

• Click the Browse... button, select the Tutorial.abs file in the Tutorial  directory from the
Open dialog box, and click the Open button.  The Load Program dialog box is displayed.
Click the Open button to start to download the file.
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Figure 4.8   Open Dialog Box (Object File Selection)

When the file has been loaded the dialog box shown in figure 4.9 displays information about the
memory areas that have been filled with the program code.

Figure 4.9   HDI Dialog Box

• Click OK  to continue.

The program has been loaded into the on-chip ROM.

4.4.2 Displaying the Program Listing

The HDI allows you to debug a program at a source level.

• Choose Source… from the View menu, or click the Program Source button in the toolbar.
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You will be prompted for the C source file corresponding to the object file you have loaded.

Figure 4.10   Open Dialog Box (Source File Selection)

• Select Sort.c  and click Open to display the program window.

Figure 4.11   Source Program Window
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• If necessary, choose Font... option from the Customize submenu on the Setup menu to choose
a font and size suitable for your host computer.

Initially the program window opens showing the beginning of the main  program, but you can
scroll through the program with the scroll bars to see other sections.

4.5 Using Breakpoints

The simplest debugging aid is the PC break, which lets you halt execution when a particular point
in the program is reached. You can then examine the state of the MCU and memory at that point in
the program.

4.5.1 Setting a PC Break

The program window provides a very simple way of setting a PC break. For example, set a PC
break at address H'1060 as follows:

• Double-click in the BP column on the line containing address H'1040.

Figure 4.12   Setting a Breakpoint (PC Break)

The word • Break  will be displayed there to show that a PC break is set at that address. Although
not performed in this tutorial, double-clicking repeatedly in the Break column can change the
display in the cyclic order shown below to set the event for measuring the execution time between
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events (+Timer : start time measurement; -Timer : stop time measurement), point-to-point trace
(+Trace : start trace; -Trace : temporarily stop trace), or trace stop (TrStop : stop trace). When
-Trace  is followed by +Trace , trace is resumed. However, when -Trace  is followed by
TrStop , trace will not resume even after +Trace  appears.

(Blank) → Break  → +Timer  → -Timer  → +Trace  → -Trace  → TrStop  → (Blank) →
...

Note: Events -Timer and -Trace can be selected only when the corresponding +Timer and +Trace
have been set.

4.5.2 Executing the Program

To run the program from the address pointed to by the reset vector:

• Choose Reset Go from the Run menu, or click the Reset Go button in the toolbar.

The program will be executed up to the PC break you inserted, and the statement will be
highlighted in the program window to show that the program has halted.

Figure 4.13   Program Break
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The message Break=  Soft Ware Breakpoint  is displayed in the status bar to show the
cause of the break.

You can also see the cause of the last break in the System Status window.

• Choose Status from the View menu or click the Status button in the toolbar to open the
System Status window, and select the Platform  sheet.

Figure 4.14   System Status Window (Platform Sheet)

The Cause of last break  line shows that the break was a PC break. The Run Time
Count  line shows that the user program executing time (from user program start to break) is
34ms 624.000µs. The timer resolution of the event time (set by +Timer  and –Timer ) and the
run time timer’s resolution is decided by the Timer Resolution option in the target Configuration
dialog box. When using a small  resolution (e.g. 20 ns) for a long time measurement, the
inaccuracy may be large. Select the timer resolution suitable for the length of measurement time.
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4.5.3 Examining Registers

While the program is halted you can refer to the contents of the MCU registers. These are
displayed in the Registers window.

• Choose Registers from the View menu, or click the CPU Registers button in the toolbar:

Figure 4.15   Registers Window

As expected, the value of the program counter, PC, is the same as the highlighted statement,
H'1060 .

(Note: The values of the other registers may differ from those shown in the above figure.)

You can also change the registers from the Registers window.  For example, to change the value
of the PC:

• Double-click the Value column corresponding to PC in the Registers window.

The Register dialog box allows you to edit the value.

Figure 4.16   Register Dialog Box
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• Edit the value to H'1014 , the start address of the main program, and click OK .

The highlighted bar will move to the top of the main program to show the new PC value.

• Choose Go from the Run menu, or click the Go button in the toolbar, to execute up to the
breakpoint again.

4.5.4 Reviewing the Breakpoints

You can see a list of all the breakpoints set in the program in the Breakpoints window.

• Choose Breakpoints from the View menu, or click the Breakpoint button in the toolbar:

Figure 4.17   Breakpoints Window

The Breakpoints window also allows you to enable or disable breakpoints, define new
breakpoints, and delete breakpoints.
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4.6 Examining Memory and Variables

You can monitor the behavior of a program by examining the contents of an area of memory, or
by displaying the values of variables used in the program.

4.6.1 Viewing Memory

You can view the contents of a block of memory in the Memory window.

For example, to view the memory corresponding to the array main  in Byte:

• Choose Memory… from the View menu, or click the Memory button in the toolbar.

• Enter main  in the Address field, and set Format to Byte .

Figure 4.18   Open Memory Window Dialog Box

• Clicking OK  opens the Memory window showing the specified area of memory and enables
to check the contents of the memory block.

Figure 4.19   Memory Window (Byte)
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4.6.2 Watching Variables

As you execute a step of a program, it is useful to be able to look at the values of variables used in
your program, to verify that they change in the way that you expected.

For example, look at the long -type array variable a, declared at the beginning of the program,
using the following procedure:

• Click the left of array variable a and move the cursor to the position in the program window.

• Click in the Program window with the right mouse button to display a pop-up menu, and
choose Add Watch.

The Watch window will display the variable.

Figure 4.20   Watch Window (After Adding Variables)

You can double-click the + symbol to the left of symbol a in the Watch window to expand it and
display the individual elements in the array.

If necessary, select Decimal from the Radix submenu in the Setup menu, or click the
Radix=Decimal button in the toolbar to display in decimal form.
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Figure 4.21   Watch Window (Symbol Expansion)

A variable name can be specified to add a variable to the Watch window.

• Click in the Watch window with the right mouse button to display a popup menu, and choose
Add Watch....

• Enter variable name max and click the OK  button.

Figure 4.22   Add Watch Dialog Box
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The volatile long -type variable max is added to the Watch window.

Figure 4.23   Watch Window (Adding Variables)
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4.7 Stepping Through a Program

The E6000 emulator provides a range of options to perform step execution by executing an
instruction or statement at a time. The alternative step commands listed in table 4.4 are provided.

Table 4.4 Step Commands

Command Description

Step In Executes every statement, including statements within functions.

Step Over Executes a function call in a single step.

Step Out Exits a function and stops at the next statement of the calling program.

Step… Allows you to step repeatedly the specified number of times.

4.7.1 Single Stepping

• Confirm that a PC break  is set at H'1040 .

• Select Reset Go from the Run menu or click the Reset Go button in the toolbar.

The program is executed and stopped at H'1060  by set PC break .  The statement of sort(a)
will be highlighted.



46

Figure 4.24   Program Window after Executing the Reset Go Command

• Choose Step In from the Run menu, or click on the Step In button in the toolbar, to step
through the sort  statement.

Figure 4.25   Program Window after Executing the Step In Command
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Exit the function, and back to the next statement in the main  program, by choosing Step Out
from the Run menu, or clicking the Step Out button in the toolbar.

Address H'1064  will be highlighted showing that the emulator has exit from the function.

Figure 4.26   Program Window Display after Step Out Command Execution

• Use the Step In command and execute the program up to the change  function call.

Note:

When a step instruction is executed and a program counter enters the C/C++ library function or
execution routine, the Disassembly window is automatically opened.  In this state, the step
instruction is executed in an assembler level.  When the step instruction is executed in the C/C++
source level, exit the C/C++ library function or execution routine with the Step Out command and
close the Disassembly window.
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Figure 4.27   Program Window after Executing the Step In Command (2)
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4.7.2 Stepping Over a Function

The Step Over command executes a function, without single-stepping through the body of the
function, and stops at the next statement in the main  program.

• Choose Step Over from the Run menu, or click the Step Over button in the toolbar.

The program executes the change  function and stops at the beginning of the next address,
H'1098 .

Figure 4.28   Program Window after Executing the Step Over Command
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4.7.3 Displaying Local Variables

You can display local variables of a function using the Locals window.  For example, we will
examine the local variables in the function main .  This function declares five local variables: a,
j , i , min , and max.

• Choose Locals from the View menu, or click the Locals button in the toolbar.

Figure 4.29   Locals Window

 The Locals window will show nothing when there are no local variables.

• Choose Step In  from the Run menu or click the Step button in the toolbar to perform step
execution one time.

 The contents of variable min  are changed and their values are displayed.
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Figure 4.30   Local Window (After Contents of Variable min are Changed)

• Double-click the + symbol to the left of variable a in the Locals window to expand variable a
and to display the individual element of each array.

• Refer to elements of variable a before sort  function execution and confirm that random data
has been sorted in descending order.

Figure 4.31   Local Window (After Array Variable a is Sorted)
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4.8 Using the Complex Event System

So far in this tutorial we have monitored the behavior of the program by observing the contents of
an area of memory in the Memory window, or the values of variables in the Watch and Locals
windows.

Sometimes the action of a program is too complex to allow us to do this. Using the emulator’s
complex event system, you can, for example, detect the time when the program has accessed
H'1108  five times.

4.8.1 Defining an Event Using the Complex Event System

Now define an event, using the complex event system, to monitor a part of the program as follows:

• Select Hexadecimal in the Radix submenu from the Setup menu, or click the Radix = Hex
button in the toolbar to display hexadecimal.

When hexadecimal is input, prefix H' for the radix can be omitted.

• Choose Breakpoints from the View menu to display the Breakpoints window, or click the
Breakpoints button in the toolbar.

• Click in the Breakpoints window with the right mouse button, and choose Add.. to set a new
breakpoint.   

The following dialog box allows you to set the breakpoint’s properties.

• Set the Type to Event  and enter the address H'10ea  into the Address Lo box as a
condition.
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Figure 4.32   Adding Breakpoints (Address Specification)

• Click the Action tab and display the Action panel.

• To generate a break after accessing five times, enter 5 in the Required number of event
occurrences edit box.

 

Figure 4.33   Adding Breakpoints (Count Specification)

• Click OK  to define the breakpoint.
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A break occurs when address H'1108  has accessed (read or written) five times.

The Breakpoints window shows the new event you have defined.

 

Figure 4.34   Breakpoints Window

• Choose Reset Go from the Run menu, or click the Reset Go button in the toolbar.

Execution will stop at the PC breakpoint set at address H'1060 .

• Run the program from the current position, by choosing Go from the Run menu, or click the
Go button in the toolbar.
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The execution stops when address H'1108  has accessed five times.

Figure 4.35   Stopping the Program by an Event Breakpoint

The status bar will display Break = Event Break  to indicate that the break was caused by
satisfaction of the event condition.

Note: In the complex event system, after the event condition is satisfied, a delay will occur until
execution stops.
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4.9 Using the Trace Buffer

The trace buffer allows you to look back over previous MCU cycles to see exactly what the MCU
was doing prior to a specified event.

4.9.1 Displaying the Trace Buffer

You can specify the address accessed by the program to use the trace buffer to look back to see
what accesses took place.

• Open the Trace window by choosing Trace from the View menu, or click the Trace button in
the toolbar.

If necessary scroll the window down so that you can see the last few cycles. The Trace window is
displayed, as shown in figure 4.36.

Figure 4.36   Trace Window

• If necessary, adjust the width of each column by dragging the column dividers on either side of
the labels just below the title bar.

In cycle -00002 , you can see that address H'1108  has been accessed.

Note: For the H8/3887 Series, H8/3867 Series, H8/3847 Series, H8/3827 Series, H8/3847R
Series, and H8/3827R Series, the Clock column is not displayed. When execution is
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stopped by a program (PC) break, Data is displayed in the Code column, and 5770 is
displayed in the Data column.

4.9.2 Setting a Trace Filter

Currently the Trace window shows all the MCU cycles.

• Display the Trace Filter  dialog box by clicking the Trace window with the right mouse
button and selecting Filter... from the popup menu.

This allows you to define a filter to restrict which cycles will be displayed in the trace buffer.

• If necessary, click General to show the General panel.

• Select Pattern  in the Type section.

• In the Address section click Address  and type H'1108  in the Address Lo field.

Figure 4.37   General Panel in Trace Filter Dialog Box
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• Click Bus / Area to display the Bus / Area panel.

• Set Bus State to CPU Prefetch .

Figure 4.38   Bus / Area Panel in Trace Filter Dialog Box

• Click OK  to save the trace filter.

In the Trace window, only the cycles in which the MCU accessed address H'1108  are displayed.
The program has stopped by accessing H'1108  five times.
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Figure 4.39   Showing Trace Buffer Contents

4.10 Stack Trace Function

The function-call history can be checked by using the stack trace function when the user program
is halted.

• Double-click the BP column of the line that includes address H'10c8  and set a PC break.

• Select Reset Go from the Run menu or click the Reset Go button in the toolbar, and execute
the program from the beginning.

Execution stops at address H'10c8  by the PC break that has been set.

• Select Stack Trace from the View menu to open the Stack Trace window.
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Figure 4.40   Stack Trace Window

Figure 4.40 shows that the position of the program counter is currently at the selected line of the
sort()  function, and that the sort()  function is called from the main()  function.

Note: This function can be used only when the load module that has the Dwarf2-type debugging
information is loaded.

For details on the functions described above, refer to the on-line help, which can be displayed by
clicking the Help button or pressing the F1 key when the target window is open.
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4.11 Saving the Session

Before exiting, it is good practice to save your session, so that you can resume with the same
E6000 emulator and HDI configuration at your next debugging session.

• Choose Save Session from the File menu.

• Choose Exit from the File menu to exit HDI.

4.12 What Next?

This tutorial has introduced you to some of the key features of the E6000 emulator, and their use
in conjunction with the HDI. By combining the emulation tools provided in the E6000 emulator
you can perform extremely sophisticated debugging, allowing you to track down hardware and
software problems efficiently by precisely isolating and identifying the conditions under which
they occur. For details on HDI operation, refer to the Hitachi Debugging Interface User’s Manual,
supplied separately.
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Section 5   Reference

This section gives reference information about the features of the HDI specific to the H8/3887
series, H8/3867 series, H8/3847 series, H8/3827 series, H8/3847R series, and H8/3827R of
microcomputers. For information about the general features of the HDI, common to all targets,
refer to the Hitachi Debugging Interface User’s Manual, supplied separately.

Table 5.1 shows the correspondence between the HDI menus and the descriptions in Hitachi
Debugging Interface User’s Manual (HDI manual) and this manual.

Table 5.1 Correspondence Between HDI Menus and Descriptions in Manuals

Menu Bar Pull-Down Menu HDI Manual This Manual

New Session... O —

Load Session... O —

Save Session O 4.11

Save Session As... O —

Load Program... O 4.4

Initialize O —

File Menu

Exit O —

Cut O —

Copy O —

Paste O —

Find... O —

Edit Menu

Evaluate... O —

Breakpoints O 4.5.4, 4.8.1, 5.2, 5.3

Command Line O 5.7

Disassembly... O —

I/O Area O —

Labels O —

View Menu

Locals O 4.7.3

Memory... O 4.6.1

Performance Analysis O —

Registers O 4.5.3

Source... O 4.4

Notes: 1. O :  Described
— :  Not described

2. The numbers in the This Manual columns are the reference section numbers.
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Table 5.1 Correspondence Between HDI Menus and Descriptions in Manuals (cont)

Menu Bar Pull-Down Menu HDI Manual This Manual

Status O 4.5.2

Trace O 4.9, 5.5

View Menu
(cont)

Watch O 4.6.2

Reset CPU O —

Go O 4.5.2

Reset Go O 4.5.2

Go To Cursor O —

Set PC To Cursor O —

Run... O —

Step In O 4.7

Step Over O 4.7

Step Out O 4.7

Step... O —

Run Menu

Halt O —

Refresh O —

Load... O —

Save... O —

Verify... O —

Test... O —

Fill... O —

Copy... O —

Compare... O —

Configure Map... O 4.3.2

Memory Menu

Configure Overlay... O —

Status bar O —

Options... O —

Radix O —

Customize O —

Setup Menu

Configure Platform... O 4.3.1, 5.1

Notes: 1. O :  Described
— :  Not described

2. The numbers in the This Manual columns are the reference section numbers.
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Table 5.1 Correspondence Between HDI Menus and Descriptions in Manuals (cont)

Menu Bar Pull-Down Menu HDI Manual This Manual

Cascade O —

Tile O —

Arrange lcons O —

Window Menu

Close All O —

Index O —

Using Help O —

Search for Help on O —

Help Menu

About HDI O —

Notes: 1. O :  Described
— :  Not described

2. The numbers in the This Manual columns are the reference section numbers.

5.1 Configuration Dialog Box

Figure 5.1   Configuration Dialog Box
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The Configuration  dialog box allows you to set up the E6000 emulator.

To display the configuration dialog box, choose Configure Platform…  from the Setup menu.

Table 5.2 explains the options provided in the Configuration  dialog box.

Table 5.2 Configuration Options

Option Description

Device Specifies the MCU device.

Mode Specifies the MCU operating mode. Mode is fixed to 3.

Clock Specifies the MCU clock rate. Can be set to:
0.5MHz, 2 MHz, 8 MHz, or Target /2 (H8/3887 Series, H8/3867 Series,
H8/3847 Series, H8/3827 Series, H8/3847R Series, and H8/3827R Series
system clock).
Specifies the MCU subclock rate. Can be set to 32.768 kHz, 38.4 kHz,
307.2 kHz, or Target.

Timer Resolution Specifies the minimum time used for performing execution time
measurements. Can be set to one of the following values: 20 ns, 125 ns,
250 ns, 500 ns, 1 µs, 2 µs, 4 µs, 8 µs, or 16 µs.

User Signals Allows you to disable or enable the user reset signal. When the box is
checked the signal is enabled.

Enable read and write
on the fly

Allows HDI access to user memory in run mode.

Enable boot mode Allows boot programming operation for flash memory in the MCU. This
option cannot be used in the H8/3887 Series, H8/3867 Series, H8/3847
Series, H8/3827 Series, H8/3847R Series, and H8/3827R Series.

Break on access error Causes all illegal accesses to halt emulation. If not checked, all writes to
ROM or accesses to the guarded area are ignored.

User VCC Threshold Monitors the user’s system voltage level and, if it falls below the value set
by the threshold, informs the user that the User VCC is down using the
System Status window.
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5.2 Breakpoints

Figure 5.2   Breakpoints Window

The Breakpoints window displays a list of all the breakpoints that have been defined.

To display the Breakpoints window choose Breakpoints from the View menu.

To edit an existing breakpoint double-click it, or select it in the Breakpoints list and choose
Edit... from the pop-up menu.

To enable or disable a breakpoint select it in the Breakpoints list and choose Disable/Enable
from the pop-up menu. When a breakpoint is enabled • is shown in the Enable column.

To delete a breakpoint select it in the breakpoint list and choose Delete from the pop-up menu, or
Delete All to delete all the breakpoints.

To define a new breakpoint choose Add… from the pop-up menu to display the
Breakpoint/Event Properties dialog box, and define the characteristics of the breakpoint you
want to add.

For more information about the Breakpoint/Event Properties dialog box see section 5.3,
Complex Event System.
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5.2.1 Defining Program Breakpoints

To define a program breakpoint set Type to PC Break and enter the address of the breakpoint in
the Address Lo field:

Figure 5.3   Breakpoint/Event Properties Dialog Box

Alternatively, double-click in the Break column in the program window.
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5.3 Complex Event System

The complex event system (CES) allows you to define events which depend on the state of a
specified combination of the MCU signals and provides a unified way of controlling the trace,
break, and timing functions of the E6000 emulator.

The complex event system uses the event and range channels to allow you to detect when a
specified event has occurred. Up to eight events can be combined into a sequence, in which each
event is either activated or deactivated by the occurrence of the previous event in the sequence.

Table 5.3 shows the options that can be specified for event and range channels.

Table 5.3 Event and Range Channel Options

Option Event Range

Access to a specified address or within a specified address
range.

O O

Access outside a specified address range. O

A specific value of data, with an optional mask. O O

A specific MCU access direction (read or write). O O

A specific MCU access type (instruction prefetch, etc). O O

A specific MCU access area (internal ROM, RAM, etc). O O

A signal state on one or more of the four external probes. O O

A specified number of times that the event must be triggered. O

Can be combined into a sequence. O

O:  Can be specified.

The Breakpoint/Event Properties dialog box allows you to define complex events for use with
breakpoints, trace, and execution timing.

To define an event breakpoint set Type to Event. The Breakpoint/Event Properties dialog box
then provides four panels of options to allow you define all the characteristics of the event used by
the breakpoint: General, Bus / Area, Signals, and Action:
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5.3.1 General

The General properties panel allows you to define the address and data access characteristics of
the event channel.

Figure 5.4   General Panel

Address: Allows you to activate the channel when an address, or a range of addresses is accessed.
Select Outside Range to specify that accesses to addresses outside the specified range should
trigger the channel.

Data Compare: Allows you to trigger the channel on a specific data value. Select Use Mask to
specify a mask which will be ANDed with the data before comparing it with the value.

Direction: Allows you to specify either read, write, or read and write accesses to trigger the
channel.
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5.3.2 Bus / Area

Allows you to trigger the channel on specific bus states or memory areas accessed.

Figure 5.5   Bus / Area Panel
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5.3.3 Signals

Specifies that the event should be triggered on a specific combination of the four external probe
signals.

Figure 5.6   Signals Panel
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5.3.4 Action

Specifies the action when the event is triggered.

Figure 5.7   Action Panel

Table 5.4 lists the actions that can be specified.

Table 5.4 Specifiable Actions

Action Description

Break Halts program execution.

Start Timer Starts the execution timer; see section 5.1, Configuration Dialog Box, for more
information about the timer resolution.

Stop Timer Stops the execution timer.

To delay activation of the channel for a specified number of bus cycles after it is triggered, enter
the number of bus cycles in the Delay after detection before break occurs field.

To delay activation of the channel until it has been triggered a specified number of times, enter the
required number of event occurrences in the Required number of event occurrences field.
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To create a sequence of events select the Enable Sequencing option for all events that are going
to form part of the sequence.

5.3.5 Event Sequencing

To configure the sequence check Enable Sequencing and click the Configure Sequence button in
the Action panel in any of the breakpoints. The Event Sequencing dialog box will be displayed.

Figure 5.8   Event Sequencing Dialog Box

For each event in the sequence this dialog box allows you to specify one or more other events that
will arm it or reset it.

Select the event that you want to configure from the Event drop down list box. This gives you a
choice of any events for which enable sequencing has been specified.

Then, for the currently selected event, click Is Armed By and check the events that should arm the
event.

Likewise, click Is Reset By and check the events that should reset the event.
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5.3.6 Arming Events

For example, to define an event sequence that is triggered only when a sequence of four address
reads have occurred you would define:

• 4 is armed by 3.

• 3 is armed by 2.

• 2 is armed by 1.

The Event Sequencing dialog box displays a diagrammatic representation of the sequence you
have defined.

Figure 5.9   Event Sequence Diagram

Note that when defining a sequence only the last event in the sequence should be defined as a
break.
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5.3.7 Resetting Events

You can also specify that events are reset by another event in the sequence. For example to cause a
break if event 2 is followed by event 3 and then by event 4, provided that event 1 has not occurred
in the meantime, define the event sequence as follows:

• 4 is armed by 3 and reset by 1.

• 3 is armed by 2 and reset by 1.

• 2 is reset by 1.

• 1 is reset by1.

Figure 5.10   Resetting Events
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5.4 Memory Mapping Dialog Box

Figure 5.11   Memory Mapping Dialog Box

The Memory Mapping dialog box shows the E6000 emulator memory mapping, and allows you
to edit it.

To display this dialog box choose Configure Map... from the Memory menu.

To edit a block of memory double-click it, or select it in the memory mapping list and click Edit .
The Edit Memory Mapping  dialog box shows the current setting for the block of memory.

Figure 5.12   Edit Memory Mapping Dialog Box

Specify the range of addresses for the block of memory in the From and To fields, and select the
type of memory from the Setting drop down list box. The options listed in table 5.5 are available:
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Table 5.5 Memory Type

Memory Description

Internal Accesses the MCU internal memory (ROM/RAM).

Emulator Accesses the emulation memory.

For each of these options you can specify one of the three access types listed in table 5.6:

Table 5.6 Access Types

Access Type Description

Read-write RAM.

Read-only ROM.

Guarded No access allowed.

Click Reset in the Memory Mapping dialog box to reset the memory mapping to the default
mapping for these selected MCU type and mode.
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5.5 Trace Window

Figure 5.13   Trace Window

The Trace window displays the contents of the trace buffer.

To display the Trace window choose Trace from the View menu.

The data stored in the trace buffer is displayed in both source program and assembly languages for
ease of debugging. However, if trace filtering is used then only assembly language is displayed.

Nothing is displayed when this emulator is used.

The values of four external probes are displayed in the Probes column. The left-most value
indicates probe 4 and the right-most value indicates probe 1. The value 1 shows the high level and
0 shows the low level.

Nothing is displayed in the NMI  column when this emulator is used.

Click Clear to clear the trace buffer, or click Save to save the contents of the trace buffer to a file.

By default the trace buffer captures all the execution cycles and retains the last 32768 cycles. You
can set up a filter which will restrict the traces displayed from the buffer to specified cycle
patterns.
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5.5.1 Filter

To define a filter, choose Filter...  from the pop-up menu in the Trace window.

5.5.2 Find

To search for a specific trace in the trace buffer choose Find… from the pop-up menu. The same
dialog box appears to specify the traces you want to find.

5.5.3 Cycle

To specify a specific cycle as a filter set Type to Cycle and enter the cycle number in the Cycle
box.

Figure 5.14   Trace Filter Dialog Box
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5.5.4 Pattern

To enter a filter pattern set Type to Pattern and specify the values as required.

The Trace Filter dialog box then provides three panels of options to allow you to specify which
cycles should be captured: General, Bus / Area, and Signals, see the following.

5.5.5 General

The General panel allows you to define the address and data access characteristics of the cycles to
be displayed.

Figure 5.15   General Panel
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5.5.6 Bus / Area

Figure 5.16   Bus / Area Panel
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5.5.7 Signals

Figure 5.17   Signals Panel
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5.6 Trace Acquisition

The buffer can be set up to store all bus cycles or just selected cycles. This is called trace
acquisition. To specify the trace acquisition click Acquisition in the Trace window.

The Trace Acquisition dialog box provides the following panels to allow you to specify when
trace acquisitions begins.

Figure 5.18   General Panel
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5.6.1 General

DTU Cycles check box in Suppress space is disabled. Time Stamp section allows you to acquire
the program execution time in the trace buffer. When Time Stamp is used, the following
information cannot be acquired:

• Area

• Status

• Probes

Also multiplication/division instruction cannot be displayed.

Check the Free Trace check box to disable all trace acquisition conditions. This temporarily
disables trace acquisition without deleting the conditions. With Free Trace checked all bus cycles
are captured, excluding those specified in the Suppress section, Stop panel, and Delayed Stop
panel.

The Trace Events section of the General panel allows you to define events, and event sequences,
to be used to initiate trace acquisition.

The Event drop-down list box shows all the currently-defined events.

To add a new event click Add…, and enter the details of the event in the Breakpoint/Event
Properties dialog box. For more information about the options available see section 5.3, Complex
Event System.

To edit an event select it in the Event list and click Edit….

To define a sequence of events click Sequence…. This option is only available if one or more
events have been defined with Enable Sequencing selected.

To delete an event select it in the Event list and click Delete, or click Del All to delete all the trace
events.
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5.6.2 Stop

Allows you to stop trace acquisition on the occurrence of a specified event.

Figure 5.19   Stop Panel
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5.6.3 Delayed Stop

Allows you to specify that trace acquisition should continue for a specified number of cycles after
a specified event.

Figure 5.20   Delayed Stop Panel



87

5.7 Command Line

Figure 5.21   Command Line Window

The Command Line window allows you to execute commands to automate debugging. To
display the Command Line window choose Command Line from the View menu.

For details of the additional MCU-specific command line functions refer to section 6, Command
Line Functions.
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Section 6   Command Line Functions

This section gives details of the additional MCU-specific command line functions.

For other general command line functions, refer to Hitachi Debugging Interface User’s Manual
(HDI manual). Table 6.1 shows the correspondence between the command line functions and the
descriptions in the HDI manual and this manual.

Table 6.1 Correspondence Between Command Line Functions and Descriptions in
Manuals

Command Name
Abbrevia-
tion

HDI
Manual

This
Manual Description

! — O — Comments

ACCESS AC O — Sets operation for invalid
access

ANALYSIS_RANGE AR O — Sets or displays the
performance analysis range

ANALYSIS_RANGE_DELETE AD O — Cancels the performance
analysis range

ANALYSIS AN O — Validates or invalidates the
performance analysis range

ASSEMBLE AS O — Assembles a program

ASSERT — O — Checks conditions

BREAKPOINT / EVENT BP, EN — 6.1 Sets a breakpoint or an
event

BREAKPOINT_CLEAR,
EVENT_CLEAR

BC,
EC

— 6.2 Clears a breakpoint or an
event

BREAKPOINT_DISPLAY,
EVENT_DISPLAY

BD,
ED

— 6.3 Displays a breakpoint or an
event

BREAKPOINT_ENABLE,
EVENT_ENABLE

BE,
EE

— 6.4 Enables or disables a
breakpoint or an event

BREAKPOINT_SEQUENCE,
EVENT_SEQUENCE

BS,
ES

— 6.5 Defines or clears a
breakpoint or event
sequence

Notes: 1. O :  Described
— :  Not described

2. The numbers in the table show the reference section numbers.
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Table 6.1 Correspondence Between Command Line Functions and Descriptions in
Manuals (cont)

Command Name
Abbrevia-
tion

HDI
Manual

This
Manual Description

CLOCK CK — 6.6 Sets the CPU clock rate in
the E6000 emulator

DEVICE_TYPE DE — 6.7 Selects the target device in
the E6000 emulator

DISASSEMBLE DA O — Disassembles and displays a
program

ERASE ER O — Clears the contents of the
command window

EVALUATE EV O — Evaluates an expression

FILE_LOAD FL O — Loads an object program file

FILE_SAVE FS O — Saves memory contents in a
file

FILE_VERIFY FV O — Verifies memory contents
against file contents

GO GO O — Executes a user program

GO_RESET GR O — Executes a user program
from the reset vector

GO_TILL GT O — Executes a user program
until a temporary breakpoint

HALT HA O — Stops user program
execution

HELP HE O — Displays the help message
for the command line or the
command

INITIALISE IN O — Initializes the platform

INTERRUPTS IR O — Enables or disables the
interrupt processing of the
platform (not supported in
the E6000 emulator)

LOG LO O — Manipulates the logging file

Notes: 1. O :  Described
— :  Not described

2. The numbers in the table show the reference section numbers.



90

Table 6.1 Correspondence Between Command Line Functions and Descriptions in
Manuals (cont)

Command Name
Abbrevia-
tion

HDI
Manual

This
Manual Description

MAP_DISPLAY MA O — Displays the memory map
information

MAP_SET MS — 6.8 Sets memory mapping

MEMORY_DISPLAY MD O — Displays memory contents

MEMORY_EDIT ME O — Modifies memory contents

MEMORY_FILL MF O — Fills the memory with the
specified data

MEMROY_MOVE MV O — Moves a memory block

MEMORY_TEST MT O — Tests a memory block

MODE MO — 6.9 Sets or displays the CPU
mode

QUIT QU O — Terminates the HDI

RADIX RA O — Sets a radix for input value

REFRESH RF — 6.17 Updates memory related
windows

REGISTER_DISPLAY RD O — Displays the CPU register
values

REGISTER_SET RS O — Sets the CPU register values

RESET RE O — Resets the CPU

SLEEP — O — Delays command execution

STEP ST O — Performs single-step
execution in instruction unit
or source line unit

STEP_OVER SO O — Performs step-over
execution

STEP_RATE SR O — Executes multiple steps

STEP_OUT SP O — Performs single-step
execution until the end of the
function that includes the
current PC address

Notes: 1. O :  Described
— :  Not described

2. The numbers in the table show the reference section numbers.
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Table 6.1 Correspondence Between Command Line Functions and Descriptions in
Manuals (cont)

Command Name
Abbrevia-
tion

HDI
Manual

This
Manual Description

SUBMIT SU O — Executes an emulator
command file

SYMBOL_ADD SA O — Adds a symbol

SYMBOL_CLEAR SC O — Deletes a symbol

SYMBOL_LOAD SL O — Loads a symbol information
file

SYMBOL_SAVE SS O — Saves a symbol information
file

SYMBOL_VIEW SV O — Displays a symbol

TEST_EMULATOR TE — 6.10 Tests the E6000 emulator
hardware

TIMER TI — 6.11 Sets or displays the timer
resolution for execution time
measurement

TRACE TR O — Displays trace data

TRACE_ACQUISITION TA — 6.12 Sets or displays trace
acquisition information

TRACE_COMPARE TC — 6.13 Compares trace data

TRACE_SAVE TV — 6.14 Saves trace data

TRACE_SEARCH TS — 6.15 Searches for trace data

USER_SIGNALS US — 6.16 Enables or disables user
signals

Notes: 1. O :  Described
— :  Not described

2. The numbers in the table show the reference section numbers.
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6.1 BREAKPOINT / EVENT

Abbreviation:  BP, EN

Sets a breakpoint. This command has several formats to allow different types of breakpoints to be
set.

There are three different types available. These are:

• Program breakpoints,

• Access breakpoints,

• Range breakpoints.

6.1.1 Program Breakpoints

Syntax :  bp program address

:  bp p address

This will set a program breakpoint at the address specified.

6.1.2 Access Breakpoints

Syntax :  bp access address  [ options ]

:  bp a address  [ options ]

Options are:

<options>    = [<dataopts>] [read|write] [<signalopts>]
[<busopts>] [<areaopts>] [<actionopts>] [count <countval>]
[delay <delayval>] [channel <channelno>]

<dataopts>   = data <data> [mask <mask>] [byte|word]

<signalopts> = signal ((1|2|3|4) (high|low))+

<busopts>    = bus (cpu | cpupre | sadata | sapre | cpumdata |
cpumpre)+

<areaopts>   = area (io | iram | irom | lcdram)+
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<actionopts> = action (trace | none | break|(timer (start|stop)))+

<channelno>  = 1..12

An access breakpoint causes a break if the MCU accesses the specified address in the specified
way.

6.1.3 Range Breakpoints

Syntax: bp range [outside] <address low> <address hi> [<options>]

<options>  is the same as specified in the access breakpoints.

This command will set a breakpoint that will trigger either within the addresses specified, or
outside, when the MCU accesses within or outside the specified address range.

6.1.4 Options

• data <data> [mask <mask>] [byte | word]

This allows a data comparison to be specified.  When bits are masked, the bit data
corresponding to the bits that are masked to 0 are not compared.
Example: data h’20 mask h’fff0 word . This will cause the event to occur only if the
higher 12 bits of the data bus are set to h’002.

The default is to not compare the data.

• signal ((1 | 2 | 3 | 4) (high | low)) +

With this option the event will only occur if the external probe are in the specified state.
Example: signal 1 high 3 low . This will cause the event to occur only if the signal 1 is
high and signal 3 is low. (The value of the other signals is not checked).

The default is to ignore all signals.

• bus (cpu | cpupre | sadata | sapre| cpumdata | cpumpre) +

The event only occurs if the MCU bus is in one of the specified states.
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Table 6.2 MCU Bus Status

Events MCU Status

cpu CPU data access cycle in active mode

cpupre CPU instruction prefetch cycle in active mode

sadata CPU data access cycle in subactive mode

sapre CPU instruction prefetch access cycle in subactive mode

cpumdata CPU data access cycle in medium-speed active mode

cpumpre CPU instruction prefetch access cycle in medium-speed active mode

Example: bus cpu cpupre . This will cause the event to occur only if the bus state is
prefetch or data access.

The default is to ignore the bus cycle type.

• area (io | iram | irom | lcdram) +

Similarly to ‘bus...  ’ this option causes the event to occur only if the specified areas are
being accessed.
Example: area irom iram . This will cause the event to occur only if internal ROM or
RAM is being accessed. lcdram  indicates MCU LCD RAM area access.

The default is any area.

• action (trace | none | break | (timer (start | stop)))+

Defines the action to occur when the event is detected.

The default action is to break. The other options are to start and stop the event timer that
measures the execution time between events. (There is only one timer.)

• count <countval>

Sets an event pass count in bus cycles (decimal).

• delay <delayval>

Specifies delay cycles in bus cycles for the period after an event has been occurred until
operation begins.

• channel 1..12

Sets the event detector system channel number to be defined. This is useful if you are setting
up a sequence of events since the sequencing is set up by referencing the channel numbers.
(See section 6.5, EVENT_SEQUENCE) Channels 1 to 8 are event detectors, 9 to 12 are range
detectors.
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Examples:

en access 100 Sets an access breakpoint at address 100.

bp p 110 Sets a program breakpoint at address 110.

en access 100 data 55 byte Sets an access breakpoint at address 100 and data 55
access.

bp range 12 45 Sets a range breakpoint from address 12 to 45.

bp range outside 60 89 Sets a range breakpoint that will break if address
outside 60 and 89 are accessed.

bp a 200 read Sets a access breakpoint to the read cycle of address
200.

bp a 500 write Sets a access breakpoint to the write cycle of address
500.

bp a 100 read channel 8 Sets a read access breakpoint at address 100 by
channel 8. When the channel 8 condition is satisfied, a
trigger signal is output from the external probe.
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6.2 BREAKPOINT_CLEAR / EVENT_CLEAR

Abbreviation: BC, EC

This command deletes a breakpoint that has been previously set by the user.

Table 6.3 BREAKPOINT_CLEAR/EVENT_CLEAR Parameters

Keyword Breakpoint Type

program <address> Clears a specified program breakpoint

access <address> <options> Clears a specified access breakpoint

range <address> <options> Clears a specified range breakpoint

all Removes all breakpoints

all trace Removes all trace events

channel 1..12 Removes event by the specified channel number

The <options> are as specified in BREAKPOINT/EVENT command. Only the minimum set of
options needed to uniquely identify the event need to be specified.

Examples

bc p 256 Clears a program breakpoint at address 256.

event_clear chan 5 Removes event by using channel number.

bc all Clears all breakpoints.
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6.3 BREAKPOINT_DISPLAY / EVENT_DISPLAY

Abbreviation:  BD, ED

Displays enable/disable for the currently set breakpoints. “trace” is displayed for trace events.

Example:

bd Displays all breakpoints and whether they are enabled or disabled.
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6.4 BREAKPOINT_ENABLE / EVENT_ENABLE

Abbreviation:  BE, EE

Enables or disables either a single breakpoint, or all the breakpoints.

Table 6.4 BREAKPOINT_ENABLE/EVENT_ENABLE Parameters

Parameter Keyword Description

true Enables breakpoint1

false Disables breakpoint

all All breakpoints

program <address> Program breakpoint

access <address> <options> An access breakpoint

range <address1> <address 2> A range breakpoint

<options>

2

channel 1..12 Enables or disables an event at the
specified channel number

The <options> can be specified as in BREAKPOINT/EVENT command to identify the event more
accurately.

Examples:

be true all Enables all breakpoints.

be false all Disables all breakpoints.

be false p 256 Disables program breakpoint at address 256.

be true access 12 Enables access breakpoint at 12.

be false chan 1 Disables event detector channel 1.
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6.5 BREAKPOINT_SEQUENCE / EVENT_SEQUENCE

Abbreviation:  BS, ES

Syntax:

bs <channel> [armed_by [not] <chan1> <chan2> ...]

                         [armed_by off]

                         [reset_by <chan1> <chan2> ...]

                         [reset_by off]

Allows you to define events which arm or reset an event.

Examples:

bs 1 armed_by 2 3

Means events 2 or 3 will arm event 1. The numbers are the channel numbers of the event
detectors, 1 to 8 which can be set using the channel option of the event command.

bs 2 reset_by 4

Event 2 is reset by event 4 when event 4 occurs.

The Off keyword is used to disable arming/resetting of an event by other events, the event then
becomes independent.
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6.6 CLOCK

Abbreviation:  CK

Selects or displays the source or rate of the active system clock (φ) and the subclock (φw). With no
parameters the active clock source and rate are displayed. If the clock source or rate is changed the
E6000 emulator system is reset.

In the MCU, the rate of system clock (OSC1 and OSC2) is a half of the input clock rate.

Table 6.5 CLOCK Parameters

Parameter Keyword Clock Source (Optional)

05 0.5-MHz internal clock

2 2-MHz internal clock

8 8-MHz internal clock

1

t2 Target /2

sub 32k 32.768-kHz internal subclock (φw)

sub 38k 38.4-kHz internal subclock (φw)

sub 307k 307.2-kHz internal subclock (φw)

2

sub t target subclock

Note that the user system clock can only be selected if the Vcc is supplied from the user system.

Examples

ck  Displays the current emulation clock.

ck 2 sub 32k Selects 2 MHz system clock and 32.768 kHz subclock.

When a break is detected when the subclock (32.768 kHz or 38.4 kHz) is used, the emulator
operation and display become slow. Therefore, when evaluating using the subclock, select 307.2
kHz which is the eight times the frequency of 38.4 kHz.

Notes: 1. The target system clock can be selected only when the Vcc is supplied from the user
system.

2. When using the target MCU (H8/3887 series, H8/3867 series, H8/3847 series,
H8/3827 series, H8/3847R series, and H8/3827R series), 307.2 kHz cannot be selected
as the subclock (φw).
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6.7 DEVICE_TYPE

Abbreviation:  DE

Sets up the device type to emulate, or displays current setting.

Examples:

de Displays device type.

de h8/3887 Sets device to H8/3887.
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6.8 MAP_SET

Abbreviation:  MS

This option will emulation memory mapping.

Syntax:

ms <start>  <end>  (internal | internal)   (none | read-only |
guarded)

Examples:

ms 8000 F73F Allocates internal read/write memory from
internal  H’8000 to H’F73F.

Note: internal  is used for memory areas on the chip, i.e. internal ROM, RAM, I/O, or
reserved area. The attribute of these areas cannot be changed except that the reserved area
excluding H'EE00 to H'F73F, H'F760 to H'F77F, and H'FF80 to H'FF8F can be changed to
the emulation memory by specifying Internal .
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6.9 MODE

Abbreviation:  MO

Sets and displays the MCU mode.

Table 6.6 MODE Parameter

Parameter Keyword Mode Type

1 3 3 (Single chip mode)

In the MCU, mode is fixed to 3.

Examples:

mode Lists the current mode.

mode 3 Sets mode to 3, and maps memory again.
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6.10 TEST_EMULATOR

Abbreviation: TE

Tests the E6000 emulator hardware, and performs a test of the E6000 emulator memory areas.
After running this command, the E6000 emulator system must be re-initialized.

Examples:

te Performs E6000 emulator testing.
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6.11 TIMER

Abbreviation:  TI

Allows the timer resolution to be displayed and modified. This will set the timer resolution for
measuring the execution time and execution time between events.

Table 6.7 TIMER Commands

Command Description

ti Displays the timer resolution

ti <timer resolution> Sets the timer resolution

Timer resolutions are: 20 ns, 125 ns, 250 ns, 500 ns, 1 µs, 2 µs, 4 µs, 8 µs, or 16 µs

Examples:

ti 20 Sets the timer resolution to 20 ns.

ti 250ns Sets the timer resolution to 250 ns.

ti 8 Sets the timer resolution to 8 µs.

ti 16us Sets the timer resolution to 16 µs.
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6.12 TRACE_ACQUISITION

Abbreviation:  TA

Sets or displays trace acquisition options.

Syntax:

TA [<suppress>] [<freetrace>] [<timestamp>] [<stop>] [<stopdelay>]
[<range>] [<default>]

<suppress>  = suppress dtu (true|false) (cannot be used for the MCU)

<freetrace> = freetrace (true|false)

<timestamp> = timestamp (disable | 125ns | 250ns | 500ns | 1us |
              2us | 4us | 8us | 16us | 100us )

<stop>      = stop ( disable | event <1 to 12>)

<stopdelay> = stopdelay ( disable | event <1 to 12>
              [count <count>] )

<range>     = range <1 to 4> ( disable |

                ptop <startaddr> <stopaddr> [cyclic] |

                range <1 to 12> |

                event <1 to 8> <1 to 8> [cyclic])

<default>   = default

Examples:

ta Displays all trace acquisition options.

ta stop event 1 2 Stops tracing when either event on channel 1 or
channel 2 occurs.

ta stopdelay event 1 2 count 100 Stops tracing 100 bus cycles after event on
channel 1 or channel 2 occurs.
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ta timestamp 500ns Enables trace timestamping and sets the
resolution of the timer stamp to 500 ns.

ta range 2 event 4 5 cyclic Lists trace range 2 to start trace when event 4
occurs and stop trace when event 5 occurs and
then to restart trace when event 4 occurs again.
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6.13 TRACE_COMPARE

Abbreviation:  TC

Compares a saved trace file (see trace_save) with the current trace data.

trace_compare <filename>
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6.14 TRACE_SAVE

Abbreviation:  TV

Saves the trace data to a file in binary format. The saved data can be compared with the trace using
the trace_compare command.

trace_save <filename>
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6.15 TRACE_SEARCH

Abbreviation:  TS

Search Trace results. This command will let the user search in the same way as the trace find
dialog box.

Syntax:

TS [<address>] [<dataopts>] [<signalopts>] [<busopts>]
[<areaopts>]   [<directionopts>] [<timestampopts>] [<fromopts>]

<address>       = address <address> [to <address>]

<dataopts>      = data <data> [mask <mask>] [byte|word]

<signalopts>    = signal <sig><sig><sig><sig>

       <sig>    = (1|0|x) 1 = high, 0 = low, x = don’t care

<busopts>       = bus (cpu | cpupre | sadata | sapre | cpumdata |
                  cpumpre)+

<areaopts>      = area (io | iram | irom | lcdram)+

<directionopts> = dir (read | write | either)

<timestampopts> = time <start> [ to <stop>]

<start> and <stop> should be in format 0s 000ms 000us 000ns

<fromopt> =from <record>

Examples:

ts address 104 data 55aa w Searches trace data for the cycles that accessed data
55aa at address 104 in word units.

ts area irom Searches trace data for the cycles that accessed the
ROM area.
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6.16 USER_SIGNALS

Abbreviation:  US

Allows the user signals (Reset) to be enabled or disabled. With no parameters this command will
display the state of the enabled/disabled flags for Reset.

Table 6.8 USER_SIGNALS Commands

Command Description

us Displays user signal status.

us enable reset Enables the signals specified.

us disable reset Disables the signals specified.
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6.17 REFRESH

Abbreviation:  RF

Updates the memory related windows.



113

Section 7   Diagnostic Test Procedure

This section describes the diagnostic test procedure using the E6000 test program.

7.1 System Set-Up for Test Program Execution

To execute the test program, use the following hardware; do not connect the user system interface
cable and user system.

• E6000 (HS388REPI60H)

• Host computer

• The E6000 PC interface board which will be one of the following boards or card:

Select one interface board from the following depending on the PC interface specifications.

ISA bus interface board (HS6000EII01H)

PCI bus interface board (HS6000EIC01H or HS6000EIC02H)

PCMCIA interface card (HS6000EIP01H)

1. Install the E6000 PC interface board in the host computer and connect the supplied PC
interface cable to the board.

2. Connect the PC interface cable to the E6000.

3. Connect the supplied AC adapter to the E6000.

4. Initiate the host computer to make it enter DOS prompt command input wait state.

5. Turn on the E6000 switch.
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7.2 Diagnostic Test Procedure Using the Test Program

Insert the CD-R (HS388REPI60SR supplied with the E6000) into the CD-ROM drive of the host
computer by pressing the Shift key, move the current directory to <Drive>:\Diag with a command
prompt, and enter one of the following commands according to the PC interface board used to
initiate the test program:

1. ISA bus interface board (HS6000EII01H)
>TM388R -ISA (RET)

2. PCI bus interface board (HS6000EIC01H or HS6000EIC02H)
>TM388R -PCI (RET)

3. PCMCIA interface card (HS6000EIP01H)
>TM388R -PCCD (RET)

Be sure to initiate the test program from <Drive>:\Diag, Do not initiate it from a directory other
than <Drive>:\Diag, such as > <Drive>:\Diag TM388R -ISA (RET).  If the test program is
initiated when the current directory is not <Drive>:\Diag the test program will not operate
correctly.

When -S is added to the command line such as >TM388R -ISA -S(RET), steps 1 to 11 will be
repeatedly executed. To stop the execution, enter Q.

Notes: 1. When the CD-R is inserted into the CD-ROM drive without pressing the Shift key, the
HDI installation wizard is automatically started.
In such a case, exit the HDI installation wizard.

2. <Drive> is a drive name for the CD-ROM drive.

3. Do not remove the CD-R from the CD-ROM drive during test program execution.
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It will take about 6 minutes to execute the test program when the host computer using
Windows® 95 runs at 166 MHz and the PCMCIA interface card is used.  The following messages
are displayed during the test.  Tests are from no.1 to no.11.

Message Description

E6000 H8/3880(16MHZ) EMULATION BOARD Tests V1.1

             Hitachi Ltd (1999)

Test program start message.
Vx.x shows the version number.

Searching for interface card ...............................OK Shows that the PC interface

board is correctly installed in

the host computer, and displays

the address when the ISA bus

interface is installed. The

displayed address depends on

the settings.  When the PCI

interface board or PCMCIA

interface card is installed, the

address is not displayed.

Checking emulator is connected .............................OK Shows that the E6000 is

correctly connected to the host

computer.

   Emulator Board Information:

     Main Board ID       H'1

Shows the ID number of the

lower board of the E6000

(always 1).

     Emulation Board ID  H'1a Shows the ID number of the

upper board of the E6000

(always 1).

     SIMM                No SIMM module inserted Shows whether the SIMM

memory board is installed.

01) Testing Rgister :

    IDR Register ...........................................OK

    BOC control register ...................................OK

    MODERE register ........................................OK

    MODERO register ........................................OK

Shows the check results for the

registers in the E6000 (normal

completion).
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02) Testing Dual-Port RAM :

    Decode Test ............................................OK

    Marching Test ..........................................OK

Shows the results of decoding

test and step test for the dual-

port RAM in the E6000 (normal

completion).

03) Testing Firmware RAM :

    Decode Test.   page range H'700 - H'71f ................OK

Shows the results of decoding

test for the firmware RAM in

the E6000 (normal completion).

    Marching Test. page range H'700 - H'71f ................OK Shows the results of step test

for the firmware RAM in the

E6000 (normal completion).

04) Testing Trace RAM :

    Decode Test.   page range H'000 - H'04f ................OK

Shows the results of decoding

test for the trace RAM in the

E6000 (normal completion).

    Marching Test. page range H'000 - H'04f ................OK Shows the results of step test

for the trace RAM in the E6000

(normal completion).

05) Testing Mapping RAM :

    Decode Test.   page range H'200 - H'21f ................OK

Shows the results of decoding

test for the mapping RAM in

the E6000 (normal completion).

    Marching Test. page range H'200 - H'21f ................OK Shows the results of step test

for the mapping RAM in the

E6000 (normal completion).

06) Testing Emulation RAM :

    Decode Test ............................................OK

    Marching Test ..........................................OK

Shows the results of decoding

test and step test for internal

ROM and RAM in the E6000

(normal completion).
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07) Testing STEP Operation :

    Single Step Operation ..................................OK

    Step Into Operation ....................................OK

Shows the check results for the

step execution controlling

circuits in the E6000 (normal

completion).

08) Testing Key Break :

    Key Break ..............................................OK

Shows the check results for the

forced break controlling circuits

in the E6000 (normal

completion).

09) Testing Emulation RAM Hardware Break :

    GRD Break ..............................................OK

    WPT Break ..............................................OK

    IN Rom  ................................................OK

    EML RAM Write  .........................................OK

    Access Error Break  ....................................OK

Shows the check results for the

illegal access break controlling

circuits in the E6000 (normal

completion).

10) Testing Go Reset .......................................OK Shows the check results for the

internal ROM write-protection

controlling circuits in the

E6000 (normal completion).

11) Tseting Double Stack, I/O Stack Test :

    Double Stack ...........................................OK

    I/O Stack ..............................................OK

Shows the check results for the

hardware break control circuits

in the E6000 (normal

completion).

0 total errors Total number of errors.

Tests passed, emulator functioning correctly Shows that the E6000 is

correctly operating.

When detecting an error, the test program displays ERROR and stops execution. In this case, the
emulator hardware may be malfunctioning. Inform a Hitachi sales agency of the test results in
detail.


	Cover
	Cautions
	IMPORTANT INFORMATION
	SAFETY PAGE
	About This Manual
	Contents
	Section 1 Introduction
	1.1 Debugging Features
	1.1.1 Breakpoints
	1.1.2 Trace
	1.1.3 Execution Time Measurements

	1.2 Complex Event System (CES)
	1.2.1 Event Channels
	1.2.2 Range Channels
	1.2.3 Breaks and Timing

	1.3 Hardware Features
	1.3.1 Memory
	1.3.2 Operating Voltage and Frequency Specifications
	1.3.3 Clocks
	1.3.4 External Probes
	1.3.5 Environment Conditions
	1.3.6 Emulator External Dimensions and Mass


	Section 2 Setting Up
	2.1 Package Contents
	2.2 Installing the PC Interface Board
	2.2.1 Setting Up

	2.3 Setting Up the PC Interface Board on Windows NT4.0
	2.4 Installing the HDI
	2.5 Troubleshooting
	2.5.1 Faulty Connection
	2.5.2 Communication Problems


	Section 3 Hardware
	3.2 Power Supply
	3.2.1 AC Power-Supply Adapter
	3.2.2 Polarity

	3.3 Hardware Interface
	3.3.1 Signal Protection
	3.3.2 User System Interface Circuits
	3.3.3 Clock Oscillator
	3.3.4 External Probes/Trigger Output
	3.3.5 Voltage Follower Circuit

	3.4 Differences between MCU and E6000 Emulator
	3.4.1 A/D Converter
	3.4.2 Access to Unused Area
	3.4.3 Program Execution by the Go Reset Command


	Section 4 Tutorial
	4.1 Introduction
	4.2 Starting HDI
	4.2.1 Selecting the Target Platform

	4.3 Setting up the E6000 Emulator
	4.3.1 Configuring the Platform
	4.3.2 Mapping the Memory

	4.4 Downloading the Tutorial Program
	4.4.1 Loading the Object File
	4.4.2 Displaying the Program Listing

	4.5 Using Breakpoints
	4.5.1 Setting a PC Break
	4.5.2 Executing the Program
	4.5.3 Examining Registers
	4.5.4 Reviewing the Breakpoints

	4.6 Examining Memory and Variables
	4.6.1 Viewing Memory
	4.6.2 Watching Variables

	4.7 Stepping Through a Program
	4.7.1 Single Stepping
	4.7.2 Stepping Over a Function
	4.7.3 Displaying Local Variables

	4.8 Using the Complex Event System
	4.8.1 Defining an Event Using the Complex Event System

	4.9 Using the Trace Buffer
	4.9.1 Displaying the Trace Buffer
	4.9.2 Setting a Trace Filter

	4.10 Stack Trace Function
	4.11 Saving the Session

	Section 5 Reference
	5.1 Configuration Dialog Box
	5.2 Breakpoints
	5.2.1 Defining Program Breakpoints

	5.3 Complex Event System
	5.3.1 General
	5.3.2 Bus / Area
	5.3.3 Signals
	5.3.4 Action
	5.3.5 Event Sequencing
	5.3.6 Arming Events
	5.3.7 Resetting Events

	5.4 Memory Mapping Dialog Box
	5.5 Trace Window
	5.5.1 Filter
	5.5.2 Find
	5.5.3 Cycle
	5.5.4 Pattern
	5.5.5 General
	5.5.6 Bus / Area
	5.5.7 Signals

	5.6 Trace Acquisition
	5.6.1 General
	5.6.2 Stop
	5.6.3 Delayed Stop

	5.7 Command Line

	Section 6 Command Line Functions
	6.1 BREAKPOINT / EVENT
	6.1.1 Program Breakpoints
	6.1.2 Access Breakpoints
	6.1.3 Range Breakpoints
	6.1.4 Options

	6.2 BREAKPOINT_CLEAR / EVENT_CLEAR
	6.3 BREAKPOINT_DISPLAY / EVENT_DISPLAY
	6.4 BREAKPOINT_ENABLE / EVENT_ENABLE
	6.5 BREAKPOINT_SEQUENCE / EVENT_SEQUENCE
	6.6 CLOCK
	6.7 DEVICE_TYPE
	6.8 MAP_SET
	6.9 MODE
	6.10 TEST_EMULATOR
	6.11 TIMER
	6.12 TRACE_ACQUISITION
	6.13 TRACE_COMPARE
	6.14 TRACE_SAVE
	6.15 TRACE_SEARCH
	6.16 USER_SIGNALS
	6.17 REFRESH

	Section 7 Diagnostic Test Procedure
	7.1 System Set-Up for Test Program Execution
	7.2 Diagnostic Test Procedure Using the Test Program


